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1 Introduction 

This K-base document contains a comprehensive listing of knowledge-base articles, which are 
common questions about the pressplay service and application. These could be frequently asked 
questions (FAQ) that will be made available in the Help/FAQ section of the pressplay application, 
or k-base only (KB Only) articles that are for Customer Care internal use. This process is 
summarized in the following figure. 

FAQs

KB Only
K-base

pressplay
Help/FAQ

Internal
Public

Customer
Care

Customer
Questions

Marketing
FAQs

 

Figure 1. K-base Data Structure and Flow 

1.1 K-base Approval Process 

This document (CC-001) contains k-base articles that have been confirmed and approved by the 
pressplay Customer Care team.  

The companion document (CC-002 New K-base Articles) is a working document that contains new 
k-base articles that were added since the last revision. Once a k-base article has been approved, it 
is transferred from the CC-002 working document, into this document.  

1.2 Numbering Convention 

Each k-base article contains a unique number to identify and organize the articles. The number is 
of the form:  

X.Y.N. ( and then the question ….) 

Where X is the category, Y is the k-base status, and N is the sequential number. For example, 
R.F.1 means the article deals with registration and is an FAQ. 

The possible values for status (Y) include: 

• F—FAQ. These are articles available to the general public. 
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• K—KB Only. These are internal articles. Discretion should be used when sharing these with 
external sources or the general population. 

The possible values for categories (X) are summarized in the following table. 

Code Category Description 

A Administrative Contains k-base articles related to profile and account 
management 

C CD Burns/PD Transfers Contains k-base articles related to burning or transferring 
Portable Downloads to CDs and portable devices (PDs) 

D Downloading Music Contains k-base articles related to downloading pressplay 
tracks  

F Finding Music and Content Contains k-base articles on searching for, browsing, etc. for 
artists, albums, and tracks, and also the content that is 
available through pressplay. 

G General  Contains general k-base questions, and questions that don’t 
fall into other categories 

L Portable Downloads Contains k-base articles describing Portable Downloads and 
the policies 

M Membership Contains k-base articles related to membership plan 
management and policies 

P Playlists and Radio Contains k-base articles related to the creation, editing, and 
playback of playlists and Radio pressplay 

R Registration and Installation Contains k-base articles related to the registration process 
through an affiliate, downloading of necessary software, etc. 

S Streaming Music Contains k-base articles related to streaming or playing 
music. This includes questions on the embedded player, etc. 

T Community Contains k-base articles related to the message board and 
community features  

 

2 Intro Blurb for FAQs 

FAQs are frequently asked questions about the pressplay policies and service. These FAQs apply 
to both the standalone pressplay application and pressplay for Windows Media Player 9 Series. 
Where the steps differ, the following icons are used to help distinguish the difference: 

<CLIENT>  This icon refers to steps or answers that are specific to the pressplay client application.  

<9 SERIES>  This icon refers to steps or answers that are specific to pressplay for Windows Media 
Player 9 Series.  

FAQs are organized according to the following main categories. 
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3 Top Ten FAQs  
 

1. What are the minimum system requirements to use pressplay? 

2. What is pressplay for Windows Media Player 9 Series?  

3. I used up all the Portable Downloads in my membership plan before my membership period 
was over—is there a way I can get more Portable Downloads?  

4. What is a Portable Download? 

5. Is my credit card information safe? 

6. What are the benefits of upgrading to Windows Media Player 9 Series?  

7. How do I make it so my member name does not appear under Now Streaming? 

8. Who can I contact if I am having issues with my portable music player? 

9. What file format and bitrate are the streaming tracks? 

10. What is Radio pressplay? 

4 General  

4.1 General FAQs 

G.F.1. What is pressplay? 

pressplay is the premier on-demand music service that will change the way you discover and 
listen to music. For a low monthly fee, you can search, browse, and instantly listen (via streaming) 
to an unlimited number of full-length songs of your choice from your favorite artists while you are 
connected to the Internet. The pressplay service also lets you download an unlimited number of 
high quality music files to your computer, and play them as much as you want, online or offline, as 
long as your membership is active. In addition, you can make your own compilations, or playlists, 
and you can even burn and transfer your favorite tracks to a CD or PD (portable device).  

G.F.2. What’s new in pressplay 2.5? 

Here are some of the major new features included with version 2.5: 

• Custom Radio—let pressplay build your own personalized radio stations based on your 
listening preferences 

• The Mix—build your own compilations based on professionally programmed playlists. You 
can burn these custom mixes and even print customized CD inserts and labels for your 
CD. 

• Billboard Charts—peruse the top hits of today or seasons past 
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• Member Get Member—share pressplay with your friends and family and get rewarded! 
Not only will you receive 10 free Portable Downloads if your referral signs up for pressplay, 
but so will they! 

• 30-Second Clips—for tracks that are Portable Download only, we are providing 30-
second clips to let you preview the tracks before burning or transferring 

G.F.3. What’s new in pressplay 2.5.1? 

Version 2.5.1 is a maintenance release that contains some important behind the scene 
performance enhancements and fixes.  

G.F.4. How can I get a quick overview of pressplay without having to sign up for the free trial? 

Check out the flash tour on our Web site that gives a great overview of what pressplay is all about. 
Go to www.pressplay.com and follow the link to “take a tour”. 

G.F.5. What is pressplay for Windows Media Player 9 Series? 

pressplay for Windows Media Player 9 Series lets you experience pressplay through the 9 Series 
player interface. All the benefits available from the standalone pressplay application are now 
conveniently available as a service through the 9 Series player, including unlimited streaming and 
downloading, and the option to purchase your pressplay tracks as Portable Downloads that are 
yours to keep. You can copy and transfer your Portable Downloads using the 9 Series player and 
can also merge your pressplay collection with your other digital media so you collect and listen to 
your music all in one place.  

G.F.6. How do I launch pressplay? 

<CLIENT>  You can start pressplay in one of the following ways: 

• Click the pressplay icon on your desktop 

• Click pressplay from Window’s Start menu (Start > Programs > pressplay > pressplay) 

<9 SERIES>  pressplay for the Windows Media Player 9 Series is accessed via the Services 
button along the left side. 

G.F.7. Where can I find information about the pressplay Privacy Policy?  

You can find information about the pressplay Privacy Policy at the following site: 

http://www.pressplay.com/privacypolicy.html  

<CLIENT>  You can also view the pressplay policy offline by selecting Privacy Policy from the 
Help drop-down menu. 
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G.F.8. Is pressplay available outside the United States?  

Currently, pressplay is available to residents of the United States. 

G.F.9. What is a stream? 

Streaming means you can listen on-demand while you are connected to the Internet, without 
having to download the track to your hard drive. Streaming is like playing a song on the radio, 
except with pressplay you can choose what you want to hear and when you want to hear it. 
pressplay streams are on-demand with the freedom to pause, rewind, or skip ahead. All tiers of 
the pressplay service offer unlimited streaming of commercial-free tracks from the pressplay library. 

G.F.10. What is a download? 

A download is a digital music file that you transfer to your computer using pressplay. You can play 
downloads as much as you want as long as your membership is active, and you can listen to them 
online or offline. All tiers of the pressplay service offer unlimited downloading of near CD-quality 
tracks from the pressplay library.    

G.F.11. What is a Portable Download? 

Portable Downloads are downloads which become permanent copies on your hard drive even if 
you are no longer a pressplay member. You can burn Portable Downloads to CD and transfer 
them to supported portable devices. 

G.F.12. What is a portable device transfer? 

A portable device (PD) allows you to transfer and play your Portable Downloads away from your 
computer via a portable music player. All pressplay members will be able to transfer tracks to 
compatible portable devices.  

To find out if your portable device is compatible, go to: 

http://www.pressplay.com/compatible_devices.html  

G.F.13. What is a Sony Net MD? 

The Sony Net MDTM product line uses MinDiscs (MD) to copy and playback your digital tracks. You 
can use the pressplay application to copy Portable Downloads to any of the products that support 
Net MD. 

G.F.14. What is a burn? 

“Burning music” is the process of copying Portable Downloads to a compact disc, which can then 
be played on any CD player. All pressplay members will be able to make CDs from their 
collections. You can burn an entire album, or you can burn a mixed CD with just your select 
favorites.  
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G.F.15. What is Gateway Music Vault by pressplay? 

Gateway Music Vault by pressplay is an innovative partnership between pressplay and Gateway 
that lets you purchase a Gateway PC pre-loaded with the pressplay service. In addition to the 
pressplay service pre-loaded on the PC, certain models will come pre-loaded with up to 2,000 
songs in conjunction with a special introductory offer. 

G.F.16. I do not hear anything when I try to play pressplay tracks. 

If you are not hearing anything when playing pressplay tracks, then please check the following: 

• Is your speaker volume turned down? 

• Are your speakers connected to your computer? 

• Do you have a sound card? 

• Are your speakers plugged into a power strip or an electrical socket (if applicable)? 

• Is your Windows Media Player volume turned down or muted? 

• Is your computer system volume muted or turned down? 

• Have you installed the latest drivers for your sound card and speakers?  

G.F.17. How many active sessions can I have simultaneously with my pressplay account? 

To protect your account, pressplay allows only one active sign-in at a time. If you are signed in 
already and attempt to sign in again, the previous session will be terminated. For example, if you 
forget to sign out of your pressplay account at home and then sign in from work, your home 
session will be terminated, allowing you to start a new session from work. 

G.F.18. How do I resize the pressplay window? 

<CLIENT>  Click on the lower right corner of the pressplay window and drag to change the size to 
whatever works best for you. You can also click on the full-window button in the upper right corner 
to maximize pressplay to fit your entire screen or click on the minimize button to return the player to 
your task bar. 

<9 SERIES>  Click on the lower right corner of the Windows Media Player 9 Series and drag to 
change the size to whatever works best for you. You can also click on the full-window button in the 
upper right corner to maximize pressplay to fit your entire screen or click on the minimize button to 
return the player to your task bar. 

G.F.19. Can I use pressplay to manage and listen to my MP3s or other non-pressplay tracks? 

<CLIENT>  At this time we do not allow non-pressplay content to be incorporated into the 
pressplay application. However, if you download Windows Media Player 9 Series, you can access 
your existing pressplay account and manage all of your tracks in one convenient location. 



pressplay K-base  General 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 8 
 

<9 SERIES>  If you are using pressplay through Windows Media Player 9 Series, you  can use the 
Media Library to manage and listen to non-pressplay tracks, along with your pressplay downloads. 

G.F.20. What guidelines does pressplay use to determine if a track contains "explicit content"? 

For a complete description of the parental advisory program whose guidelines we use to determine 
which tracks contain explicit content go to: 

www.parentalguide.org 

G.F.21. Why did I get signed out of my pressplay account? 

If you are inactive for 6 or more hours, pressplay will automatically terminate your session.  All you 
need to do to get back on pressplay is to sign in again.  

You are also allowed only one active session at a time. If you are already signed in and then sign in 
from another computer, you will automatically be signed out of the previous session. 

G.F.22. Does pressplay use cookies?  

As part of the sign-in process, pressplay may use persistent cookies. We use these cookies in 
connection with a sign-in feature that allows you to save your member name and password so that 
the next time you sign in, these fields will be pre-populated for you. This cookie is only offered in 
conjunction with certain affiliates and it can only be activated if you select that option during sign-in. 
If you select this option you can always deselect it the next time you sign-in. If your browser is 
configured to not allow cookies, or you delete these cookies, pressplay will still function; you will 
just have to type in your member name and password every time you sign in. 

pressplay may also use several "session" cookies that only last as long as you are online. We use 
these cookies to identify you as a valid subscriber, to ensure that no one else can sign on 
simultaneously with your account from another computer, and to help us personalize your service 
experience based on your registration preferences (such as genre). We may also use session 
cookies to help us facilitate any promotions or surveys that we provide. These cookies do not 
contain any personally identifiable information and we do not store data collected by these cookies. 
Please review our privacy policy at www.pressplay.com/privacypolicy.html for more details. 

We sometimes use cookies within the promotional e-mails that we send to our members. The 
information generated from these e-mails is related to non-personally identifiable customer 
identification numbers and is only analyzed at aggregate levels. We may send these e-mails via 
third-party service providers that act on our behalf. Our advertisers and other third parties whose 
products or services are promoted on our site may also use cookies, and we advise you to check 
their privacy policies for information about their cookies and other privacy practices.     

G.F.23. Who do I contact if I suspect that any use or part of the pressplay service constitutes 
copyright infringement?" 

If you know of or suspect that any use of the pressplay service, tracks, materials and/or application 
constitutes copyright infringement, please send a notice by e-mail to privacy@pressplay.com, or by 
fax to 310.281.5120. The notice must contain the following information: (a) a physical or electronic 
signature of the copyright owner or a person authorized to act on the copyright owner’s behalf; (b) 
description of the copyrighted work(s) that is/are allegedly being infringed; (c) the location of the 
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allegedly infringed work(s); (d) your current contact information (e.g. address, phone number, and 
e-mail address); (e) a statement that you have a “good faith belief” that the use of the complained-
of copyrighted work(s) is not authorized by the copyright owner, its agent, or the law; and (f) a 
statement by you signed under penalty of perjury that all the information you provide in the notice is 
accurate and that you are the copyright owner or a person authorized to act on the copyright 
owner’s behalf (all of this collectively is a “Notice”). 

G.F.24. How do I contact pressplay Customer Care?  

In order to receive quality Customer Care, please contact pressplay Customer Care using the 
provided help request form on the pressplay service: 

<CLIENT>  Choose Help  > Customer Care from the drop-down menu.  

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click the Help link, and then 
follow the link to Customer Care.  

Or you can call a trained Customer Care professional at this toll-free number, 888.660.2265. 
Customer Care is available seven days a week from 8 a.m. to 8 p.m. CST. 

G.F.25. Who do I contact if I have a media-related question?  

Please direct your inquiries to media@pressplay.com.  

G.F.26. How do I queue up tracks so they start playing after the ones that are currently playing 
finish? 

To queue up a track or tracks: 

<CLIENT>  Select the track(s) and then right-click and choose Add to Now Playing from the drop-
down menu.  

<9 SERIES>  Select the track(s) and then right-click and choose Add to Current Playlist from the 
drop-down menu. 

These tracks will begin to play after the current tracks finish playing. You can keep adding more 
tracks in this manner, and they will be queued up to play in the order they were added.  

G.F.27. How do I access pressplay Help? 

<CLIENT>  Help is available by pressing the F1 key on your keyboard or selecting the 
corresponding option from the Help drop-down menu.  

<9 SERIES>  Go to the pressplay HOME tab and click OPTIONS/HELP, and then click the Help 
link. Also note that Windows Media Player 9 Series help is available through the Help drop-down 
menu along the top of the 9 Series player. 
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pressplay help options include frequently asked questions (FAQ), an online user guide, help 
request forms, and information on how to contact Customer Care. 

G.F.28. What are the benefits of upgrading to Windows Media Player 9 Series? 

There are many reasons to upgrade to Window Media Player 9 Series including reduced buffering 
and better stream quality. You can benefit from the enhancements of Windows Media Player 9 
even if you are using the pressplay standalone application, as it uses 9 Series technology behind 
the scenes. You can get the latest free version of the 9 Series player at: 

http://windowsmedia.microsoft.com/download/download.asp  

G.F.29. How do I contact Windows Media Player 9 Series Customer Support? 

If you have questions or issues with your Windows Media Player 9 Series, please refer to the 
Microsoft Web site for support information: 

http://support.microsoft.com  

4.2 General K-base Only   

G.K.1. Why do I have to sign in? 

The most secure method to ensure that no one else is using your account is to require a sign-in. To 
create a seamless user experience between pressplay and the affiliate you signed up through, in 
some cases we are using the affiliate for sign-in services. 

G.K.2. How do I turn off or control which advertisements I view on pressplay?   

pressplay does not currently have advertising on its service. 

G.K.3. Why should I buy music online if I can get it for free?  

pressplay content is worth it! You get what you pay for, including a secure and easy downloading 
experience (fast and reliable downloads are always available from a central server) and better-
sounding audio. In addition, pressplay’s music is provided by record labels that support the 
recording artists, ensuring that artists are paid for their music. pressplay also provides quick 
reference to artist information and images, a programming staff that provides radio stations and 
recommendations, flexibility to transfer or burn your Portable Downloads, and the convenience and 
peace of mind of having all your digital music stored in one reliable place. 

G.K.4. What type of Digital Rights Management software does pressplay use? 

pressplay utilizes the Microsoft Windows Media Digital Rights Management software to protect 
audio tracks. For more information about the Microsoft DRM, go to: 

http://www.microsoft.com/windows/windowsmedia/drm.asp  
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G.K.5. What is Windows Media Player? 

Windows Media Player is digital audio and video software that plays pressplay tracks and a variety 
of other music formats. A free version of Windows Media Player is available when you purchase a 
pressplay membership, or at the following Web address: 

http://windowsmedia.microsoft.com/download/download.asp  

G.K.6. How do I buy a CD from pressplay?  

<CLIENT>  By clicking on the BUY CD button next to the album cover graphic, you will be taken to 
one of our retail partners to purchase CDs. All of the albums that are for sale through our retail 
partners are available for download through the pressplay membership. 

G.K.7. I am an independent musician and/or work for an independent record label, how can I get 
my music featured on pressplay?  

Thanks for your interest in pressplay. 

pressplay intends to offer promotional showcases for independent artists after our service launches 
later this year. We plan to spotlight these artists, which will be selected by the Music Programming 
department from those submitted, on a rotating basis. Please send submissions*, in audio CD 
format, together with your contact information, to our Independent Artist Coordinator at the 
following address: 

pressplay Music Programming 
Attn: Independent Artist Coordinator 
9044 Melrose Ave. 
Los Angeles, CA 90069 

*Please note that all submissions to the independent artist coordinator become the property of 
pressplay and cannot be returned. Further, submission does not guarantee selection for use in the 
service. We will contact you if we would like to utilize your music in the service. 

Best Regards, 

pressplay Independent Artist Coordinator 

G.K.8. What is the pressplay refund policy? 

< NOTE: CUSTOMER CARE REPS SHOULD REFER TO CC-003 CUSTOMER CARE 
POLICIES FOR MORE SPECIFIC INFORMATION.> 

Refunds will only be issued under extenuating circumstances. For example, if you sign up for 
pressplay and you do not meet the minimum system requirements or for some other reason you 
are not able to use the service, you will be eligible for a refund. 
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G.K.9. How to handle inquiries from the press  

I am not authorized to speak on behalf of the company; please contact Sherri Weiss at 
212.453.2237 or media@pressplay.com.  

G.K.10. Playback skips, downloads are slow, or other sluggish behavior related to low system 
resources. 

Possible things to check: 

• Is the issue with your Internet connection? Verify that your specified connection speed  is 
correct. 

• Do you have at least 64 MB of RAM? Computers with 32 MB may occasionally skip or 
have other performance issues, especially with other software applications open. 

• Are you running other software applications that are taxing your system resources? 

• Certain software such as Total Recorder may have compatibility issues with Windows 
Media Player. Especially check for any device that sets itself as the default device for 
playback and recording. 

G.K.11. After upgrading Operating Systems, I experienced problems with pressplay. 

If you upgraded your operating system after you installed pressplay, you may have to completely 
uninstall and reinstall Windows Media Player for pressplay to function.  

To uninstall Windows Media Player, select Start > Settings > Control Panel > Add/Remove 
Software. Locate Windows Media Player and click Change/Remove.  

To download and install the latest Windows Media Player, go to: 

 http://windowsmedia.microsoft.com/download/download.asp  

G.K.12. Response for temporary technical difficulties. 

Thank you for contacting pressplay. We are experiencing temporary technical difficulties. We are 
aware of the issue and are working very hard to resolve it. Please try again later and if at that point 
you are still unsuccessful, please feel free to contact us again. Thank you for your patience, we 
apologize for the inconvenience.  

G.K.13. Why does it appear that pressplay is trying to communicate with my network? 

The behavior you observe is part of the normal operation of our backend systems. To ensure 
optimal performance, our servers routinely ping your computer in order to deliver content with the 
minimum delay. This process is completely harmless and does not compromise your system in 
any way, although some commercial firewalls may report this as a port scan. 
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G.K.14. If I have Windows 2000 or XP, what permissions settings do I need to use pressplay? 

For networked Windows 2000 and XP users, your login should contain administrative privileges to 
correctly use pressplay. You should have Administrator (or the equivalent) or Power User login 
privileges. Contact your network administrator for details on verifying whether you have the correct 
privileges for your login. 

G.K.15. I am running ad-blocking software and cannot sign in to pressplay. 

If you have ad-blocking software (such as AdSubtract, PopUp Killer, or @Guard) you may have to 
configure accordingly to use pressplay. The root URL that pressplay accesses is 
http://admin.pressplay.com. Your ad-blocking software should be configured to allow URLs from 
this root. 

G.K.16. I have Windows configured for large or custom fonts, and pressplay prompts me that it 
needs to use small fonts. 

The pressplay interface does not currently support large or custom fonts. If you are using 
large/custom fonts and try to sign in to pressplay, you will be prompted to change your font 
preference in the Windows Display properties. If you want to keep using large/custom fonts, the 
visual layout of your pressplay interface may be compromised but will still be functional. If you want 
to ignore this message in the future, click the “Don’t show this message again” checkbox, or you 
can also configure this under your Options: 

G.K.17. How do I change my Windows Display preferences to use small fonts? 

To change your font preference to the default small fonts used by pressplay: 

 

1. Right-click on your desktop to get the Display Properties.  

2. Go the Settings tab and click the Advanced… button.  

3. Select Small Fonts from the Font Size drop-down menu, and then click OK.  

4. You may then be prompted to reboot your computer. 

G.K.18. General Windows Media Player 9 Series issues where customer does not have version 
2799 or higher.  

Version 2799 or higher of the Windows Media Player 9 Series is the only authorized build 
supported by pressplay. If you have a version number that is less than 2799, this build is not 
authorized and you must uninstall your Windows Media Player 9 Series, and install the authorized 
beta version available from: 

http://windowsmedia.microsoft.com/download/download.asp 

G.K.19. <GATEWAY ONLY> How do I contact Gateway Customer Care?  

If you are having issues related to your Gateway PC, you can contact Gateway Support at 
800.846.2301 or by visiting the following site:  
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http://support.gateway.com/support/default.asp 

G.K.20. Business Development or other non-Customer Care Inquiries. 

If a customer’s inquiry falls outside of a request for Customer Care, but is requesting or soliciting 
services or a business proposition related to pressplay, the CCR should forward accordingly.  

Note: There are already separate k-base templates for media-related inquiries and also 
for artist or label inquires. 

Legitimate business-related inquiries should be forwarded to 
businessdevelopment@pressplay.com. If the person is inquiring via phone, the following 
information should be captured and forwarded to the above e-mail address. 

Date: 

Point of Contact Name: 

Company Name: 

Business Inquiry Description: 

E-mail Address: 

Phone Number: 

Primary Country of Business: 

The following reply should be returned to customers inquiring via e-mail: 

Thank you for your interest in pressplay. Your e-mail has been forwarded to the pressplay 
Business Development team. pressplay will review your inquiry or proposition and may 
be in contact with you for follow up if necessary.  

<FOLLOW-UP TO BUSINESS DEVELOPMENT INQUIRIES> 

If a customer sends a follow-up to a previous inquiry or proposition, or re-sends an inquiry or 
proposition, the following answer should be sent back to the customer: 

Thank you again for you interest in pressplay. pressplay reviews all inquiries but 
regretfully does not have the resources to respond to every e-mail. 

The CCR should only re-send repeated e-mails to businessdevelopment@pressplay.com if it 
seems important or relevant. If the CCR is unsure what to do with an e-mail, they should forward 
the e-mail to the CC Supervisor, or if the Supervisor is not sure, the e-mail should be forwarded to 
support@pressplay.com.  
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G.K.21. How many subscribers does pressplay have? 

We are sorry, but pressplay does not disclose this information to the public. 

G.K.22. Out of Scope Reply 

Thank you for contacting pressplay. We would like to help you with your request, but unfortunately 
we have determined that your help request falls outside of our typical commitment to Customer 
Care pertaining to the pressplay service. For more information, please go to: 

< NOTE: THE PROVIDED URL OR REFERRAL, AND VERBIAGE OF THIS REPLY 
TEMPLATE MAY VARY DEPENDING ON THE ISSUE.> 

 

G.K.23. Response for blank e-mails, or e-mail with attachments. 

The e-mail you sent us does not contain any text or contains attachments that we are not able to 
open. If we can be of any assistance, please reply or send your help request as plain text, or call us 
at 888.660.2265. 

If your e-mail was sent by mistake, please disregard this message. 

G.K.24. General Feedback Template. 

Your comments and feedback are important to us. Please keep in mind that we are continually 
working to expand the pressplay experience. Your feedback will be forwarded to the proper 
department. If we can be of assistance to you, please feel free to contact us with any questions you 
may have. 

G.K.25. Response for requests for other customer's information. 

We are not authorized to give out information about any particular member to anyone other than 
the member. 

G.K.26. Customer does not send relevant information to access account. 

In order for us to access your account, we need some additional information. Please reply with 
your pressplay member name, e-mail address used during registration, and the affiliate you 
registered through (Yahoo!, Roxio, MSN Music, MP3.com, Sony's Musiclub, pressplay connect, 
Gateway Music Vault, Rio pressplay, or pressplay (for Windows Media Player 9 Series)). After we 
receive this information, we will process your help request. 

G.K.27. Escalation and information gathering template. 

To ensure we address your specific issue accurately, it would be helpful for us to have the following 
information. Please include all previous steps and be as specific as possible.  Thank you for your 
patience. 

• Full name: 
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• Member name: 

• Your affiliate (Roxio, MSN Music, Mp3.com, Yahoo!, Sony’s Musiclub, pressplay connect, 
Gateway Music vault by pressplay, Rio pressplay, or pressplay (for Windows Media Player 9 
Series)):    

• Are you using the standalone pressplay application or pressplay for Windows Media Player 9 
Series?  

• pressplay version:     

• Your (account) e-mail: 

• Response e-mail (if different):  

• Phone: 

• Best time to be contacted (with time zone): 

• Operating system: 

• Web browser version:  

• ISP type (dialup, hi-speed, LAN): 

• True connection speed:    

• Windows Media Player version:              

• Any firewalls/virus software:                       

• What is the exact error message (if applicable)?  

• How much free disk space do you have? 

• How much RAM do you have?   

• Any other non-standard software or configurations:   

• What is the exact sequence of events leading to the issue? 

• What steps have you tried (if applicable)? 

G.K.28. Resolved Issue Closure: 

Thank you for contacting pressplay Customer Care. We are pleased to hear your issue was 
resolved. If you need assistance in the future, please feel free to contact us again, otherwise enjoy!  

We appreciate your business and thank you for making pressplay your choice for quality digital 
music.  
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G.K.29. Closing to Customer Care e-mails. 

If you need further assistance, please feel free to contact us again at pressplay Customer Care and 
we will be happy to assist you. Thank you for making pressplay your choice for quality on-demand 
music. 

Regards, 

<CCR> 

pressplay Customer Care 
e-mail: help@support.pressplay.com 
phone: 888.660.2265 
hours: 8:00 a.m. to 8:00 p.m. CST Every Day 

5 Registration and Installation 

5.1 Registration and Installation FAQs  

R.F.1. What are the minimum system requirements to use pressplay? 

pressplay's minimum system requirements are as follows: 

• Operating System—Windows 98, Windows 2000, Windows Me, or Windows XP  

Note: pressplay is not supported on Windows 95, Windows NT, or Macintosh. 

• Processor— Pentium-class CPU equivalent or better 

• Memory—64MB of RAM minimum 

• Hard Drive— approximately 2 MB for pressplay and 12-15 MB for Windows Media Player (if 
not already installed) 

• Sound Card—sound card and speakers 

• Browser—Microsoft Internet Explorer version 5.01 or higher  

Note: for IE 5.5 users, service pack 1 or higher is required. 

• Digital Music Player—Windows Media Player 7.1 (Windows Media Player 9 Series is 
recommended) 

• Connection–active Internet connection (33.3 Kbps minimum, broadband/128+ Kbps 
recommended) 

• If you plan to burn CDs you will need a supported CD burner and recordable CDs.  

• If you plan to transfer tracks to a portable device, you will need a supported PD. To see if your 
portable music player is compatible with the pressplay, go to: 
http://www.pressplay.com/compatible_devices.html   
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R.F.2. How does the free trial work?  

When you sign up for any pressplay plan, you receive a 3-day free trial that consists of unlimited 
streams and downloads. If at any point during these 3 days you decide to cancel, your pressplay 
membership will end and your credit card will not be billed. At the end of the 3-day trial, the plan 
you selected at registration will begin and your credit card will be charged. You will have access to 
the tracks you downloaded during your free trial for as long as you are an active subscriber. 

 

R.F.3. How do I get the Windows Media Player? 

When you register for pressplay, your system will be checked for the presence of the Windows 
Media Player. If you do not have Windows Media Player 7.1 or greater, you will be prompted to 
install or upgrade the player. If you need to install or upgrade Windows Media Player at any other 
time, check the Microsoft Web site for the free software at: 

http://windowsmedia.microsoft.com/download/download.asp    

R.F.4. What credit cards can I use to purchase a pressplay membership? 

pressplay currently accepts Visa, Mastercard, and American Express credit cards. Debit cards or 
ATM cards are not currently accepted. Debit cards or check cards with the Visa or Mastercard logo 
are accepted. 

R.F.5. Is my credit card information safe?  

pressplay uses industry-standard Internet security procedures for transmitting all credit card 
information. To meet this standard, all credit card information is encrypted and securely transmitted 
using SSL technology. This information will not be disclosed under any circumstances. 

R.F.6. Is there a minimum time commitment to sign up for the pressplay service? 

Currently, there is no minimum time commitment when you sign up for the pressplay service. You 
may cancel your membership at any time and only pay through the end of the final month if you 
subscribed to a pressplay Unlimited or pressplay Unlimited Plus plan. If you sign up for a pressplay 
Annual Plus membership plan, then you agree to a one-year commitment.   

R.F.7. Will pressplay work if I am behind a firewall? 

pressplay will work behind most firewalls. If you are having difficulties installing pressplay, 
upgrading your Windows Media Player, or streaming or downloading songs, we would suggest that 
you temporarily disable the firewall, or lower the security settings to see if this may be an issue.  
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R.F.8. Do I have to sign up for the pressplay service through an affiliate? 

pressplay is offered through our affiliates or directly through Windows Media Player 9 Series.  
Currently, our affiliates include: 

• Yahoo!  < http://music.yahoo.com/ > 

• MSN Music  < http://music.msn.com/ > 

• Roxio  < http://www.roxio.com/ >     

• MP3.com  < http://www.mp3.com/ >  

• Sony’s Musiclub  < http://www.musiclub.sonystyle.com/ > 

• Gateway Music Vault < http://www.gateway.com  > 

• Rio < http://www.sonicblue.com > 

• pressplay (generic) < http://www.pressplay.com > 

If you have Windows Media Player 9 Series, then you can sign up for pressplay through the link on 
the Services menu option. To get the 9 Series player, go to:  

http://windowsmedia.microsoft.com/download/download.asp  

R.F.9. How do I get updates to the pressplay software? 

<CLIENT>  To update your version of pressplay, choose Update pressplay from the My Account 
drop-down menu. You are then guided through the update process if an update is available. 

<9 SERIES>  If you are using the pressplay plug-in for Windows Media Player 9 Series, the 
pressplay plug-in will update itself automatically if an update is available. 

R.F.10. I lost pressplay from my computer, or want to get it on another computer, how can I 
download and install the pressplay software? Can I access my pressplay service from 
another location, such as work, home, or even on the road? 

You can access your pressplay account from your home or office, or anywhere that you have 
Internet access. You can play streaming files from anywhere that you have Internet access, and 
store your downloads on up to two computers.  

To re-download pressplay or install it on another computer, click on the appropriate link 
corresponding to the affiliate you signed up with: 

• pressplay on MSN Music members go to the following URL: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=9 

• pressplay on Yahoo! members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=10 
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• Roxio pressplay members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=11 

• pressplay on MP3.com members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=36 

• pressplay on Sony's Musiclub members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=87 

• pressplay connect members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=88 

• Gateway Music Vault by pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=123  

• Rio pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=143  

• pressplay (generic) members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=7 

Click on the provided link to download pressplay. 

<9 SERIES>  If you signed up for pressplay through Windows Media Player 9 Series or wish to 
use pressplay through the 9 Series player: 

 

1. Install the 9 Series player. This can be obtained at:  
http://windowsmedia.microsoft.com/download/download.asp 

2. Click the Services button on the 9 Series player. 

3. Follow the pressplay link. 

4. Follow the “I am already a member!” link.    

Note: The different versions of pressplay are treated as separate installations and you will 
need to perform a Sync/Restore to listen to your downloads on the other version. 

R.F.11. If I am signed up for pressplay through Windows Media Player 9 Series, can I also listen to 
my pressplay account through the standalone pressplay application? 

Yes, you can listen to your pressplay membership on either version of pressplay. To download the 
standalone pressplay application if you signed up through the 9 Series player: 

 

1. Go to www.pressplay.com. 

2. Follow the link for “I am already a member!” in the upper right corner. 

3. Select the generic pressplay affiliate.  

4. Follow the link to download the pressplay application. 
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Note: The different versions of pressplay are essentially treated as separate installations. 
If you download tracks on pressplay for Windows Media Player 9 Series, you will need to 
perform a Sync/Restore to listen to your downloads on the standalone pressplay 
application. If you download tracks on the pressplay application, you can access them 
through the 9 Series player as long as you add that track or folder (typically C:\My Music) 
to the Media Library. 

R.F.12. <9 SERIES>  Will removing the pressplay service from Windows Media Player 9 Series, 
cancel my membership? 

When you click Remove Service from the 9 Series player, this will un-install pressplay, but will not 
cancel your pressplay membership. If you really want to cancel pressplay and remove the program 
from your machine, you should first cancel pressplay and then remove the service.  

R.F.13. <9 SERIES>  How do I get pressplay back if I accidentally removed it from Windows Media 
Player 9 Series? 

If you accidentally removed pressplay as a 9 Series player service, you can get it back by: 

 

1. Go to the Services tab on the 9 Series player. 

2. Follow the link to sign up for pressplay. 

3. Follow the link for “I am already a member!” 

4. Clink the link to install pressplay.  

5. Follow the installation instructions and then sign into pressplay when prompted.  

Registration and Installation K-base Only 

R.K.1. Why does it take so long to download and install the pressplay software?   

The pressplay software is approximately 1.5 megabytes. On a 56.6 Kbps modem, download time 
should be approximately 7 minutes, and higher connection speeds will be even faster. If it is taking 
significantly longer than this, there may be heavy Internet traffic, or you may have problems with 
your Internet connection.  

R.K.2. When and how do I get billed? 

Each month pressplay will automatically bill the credit card number you entered during registration.  

If you signed up for the pressplay Annual Plus membership, then you will be billed annually, with 
the full amount paid at beginning of the billing period.  
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R.K.3. Can I use Netscape to run pressplay? 

Currently, pressplay does not support Netscape as a browser. To run pressplay, please go to the 
Microsoft Web site (www.microsoft.com/downloads/) to download the latest version of Internet 
Explorer for free.  

R.K.4. When I try to install pressplay, the download process just starts and hangs.  

Please check the type of browser you are using to download pressplay. The installation program 
used by pressplay, Web InstallShield, is not supported on Netscape 6.x browsers. Open Internet 
Explorer and begin the download again. If you don’t already have Internet Explorer 5.01 or greater 
installed, please get it from the Microsoft Web site:  

http://www.microsoft.com/downloads/ 

Note: If you are prompted to download the installer file directly, please follow the on-
screen instructions to install pressplay using this method. 

R.K.5. During installation or when I try to use pressplay, I get an error that says my “certificate has 
expired or is not yet valid”. 

The most likely reason for this error is that the system date on your computer is incorrect. Verify 
that your date is correct (or at least within a year of the current date) by double-clicking on the clock 
that is usually in the lower right corner of your screen. You may need to stop and start pressplay for 
any changes to be detected.    

R.K.6. <CLIENT>  I receive a “Missing Registry Key Error” (or other misc post-installation issues). 

First uninstall pressplay as follows: 

 

1. Click the Start menu and go to Control Panel > Add Remove Programs. 

2. Click pressplay, and click the Change/Remove button. 

3. Click the Remove radio button, and then click Next>.  

4. Click OK when prompted to uninstall pressplay. 

Now, re-install pressplay. Click on the appropriate link corresponding to the affiliate you signed up 
with: 

• pressplay on MSN Music members go to the following URL: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=9 

• pressplay on Yahoo! members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=10 

• Roxio pressplay members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=11 
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• pressplay on MP3.com members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=36 

• pressplay on Sony's Musiclub members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=87 

• pressplay connect members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=88  

• Gateway Music Vault by pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=123  

• Rio pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=143 

• pressplay (generic) members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=7 

Click on the provided link to download pressplay. 

<9 SERIES>  If you signed up for pressplay through Windows Media Player 9 Series or wish to 
use pressplay through the 9 Series player: 

 

1. Install the 9 Series player. This can be obtained at: 
http://windowsmedia.microsoft.com/download/download.asp 

2. Click the Services button on the 9 Series player. 

3. Follow the pressplay link. 

4. Follow the “I am already a member!” link.    

Note: The different versions of pressplay are treated as separate installations and you will 
need to perform a Sync/Restore to listen to your downloads on the other version. 

R.K.7. Can I install pressplay on a Macintosh?  

Currently, pressplay is available only on IBM-compatible PCs. We are confident that we will be able 
to provide the pressplay service to our valued Macintosh customers in the near future. 

R.K.8. Can I access the pressplay service through another pressplay affiliate other than where I 
originally subscribed?  

Each pressplay affiliate builds its own unique version of the pressplay service that is not 
interchangeable. Because of this we ask that you only access pressplay through the affiliate you 
originally registered with. 

However, if you are using the standalone pressplay application, you can access your pressplay 
account through pressplay for Windows Media Player 9 Series and if you are using pressplay for 
Windows Media Player 9 Series, you can access your account through the pressplay application.  
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R.K.9. Can a Customer Care representative sign me up? 

Sorry, since pressplay needs to be installed on your computer, you must sign yourself up. If you 
are having troubles, we can help you through the registration and installation process. 

R.K.10. Why do I have to give my credit card and personal information for a free trial?  

Your 3-day trial is free. Cancel anytime before the end of your trial and your credit card will not be 
billed. Entering a credit card number for the free trial eliminates the need for additional registration 
at the end of your 3-day trial. And, of course, your credit card information is safe as pressplay uses 
the best encryption technology available. 

R.K.11. Do I have to use a credit card or can I be billed directly? 

At this time, pressplay only accepts credit cards. Debit or ATM cards are not currently accepted.  

R.K.12. How can I tell which Microsoft operating system version and service pack number I am 
using?  

To find out which Microsoft operating system version and service pack number you are using, 
please follow these easy steps: 

 

1. Double-click the My Computer icon on your desktop. 

The My Computer window appears. 

2. Select About Windows from the Help menu. 

The operating system version and service pack number will be displayed in the About Windows 
window. 

R.K.13. How can I check which Internet Explorer version and service pack number I am using?  

To check which Microsoft Internet Explorer version and service pack number you are using: 

 

1. Launch your Internet Explorer.  

2. Select About Internet Explorer from the Help menu. 

The Internet Explorer version and service pack number is displayed in the About Internet 
Explorer window. 

R.K.14. Do I need Windows Media Player? 

Yes, Windows Media Player 7.1 or higher is required to play tracks on pressplay. To get the free 
download of the Windows Media Player, go to: 

 http://windowsmedia.microsoft.com/download/download.asp   
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R.K.15. How do I find out if Windows Media Player is already installed on my computer?  

pressplay requires Windows Media Player 7.1 or higher. To find out if you already have the 
Windows Media Player, check your desktop for the presence of a Windows Media Player icon, or 
check the Start > Programs options to see if you find it there. Windows Media Player is typically 
installed in the C:\Program Files\Windows Media Player\ folder, so you can also check to see if this 
folder exists. For more information, go to: 

http://windowsmedia.microsoft.com/download/download.asp   

R.K.16. How can I tell what version of Windows Media Player I have? 

pressplay requires Windows Media Player 7.1 or higher. To find out what version of Windows 
Media Player you have installed on your computer, please follow these easy steps: 

 

1. Start your Windows Media Player. 

2. Select the Help menu, and then About Windows Media Player. 

3. The pop-up window will display the version number. 

For more information, go to: 

http://windowsmedia.microsoft.com/download/download.asp  

R.K.17. My installation starts and locks up, or I am having other installation problems. 

If your Internet Explorer Security is set to High, then during the pressplay installation it will not 
accept cookies and you may see an endless installation circle, or the blank pressplay page.  

Note: If you are prompted to download the installer file directly, please follow those on-
screen instructions to install pressplay using that method. 

To fix the security options to accept cookies:  

 

1. Select Internet Options from the Tools drop-down menu on your browser. 

2. Click on the Security tab. 

3. With the Internet icon selected, click the Custom Level … button. 

4. Select Medium from the drop-down menu next to the Reset button. 

5. Click the Reset button. 

6. Select Yes when the Warning dialog box asks if you want to change the security settings for 
this zone. 

7. Click OK from the Security Settings window. 
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8. Click OK from the Internet Options window. 

9. Reinstall pressplay. 

R.K.18. I am not seeing the InstallShield Wizard when I attempt to download the application? 

If you do not see the InstallShield Wizard, or you just see an installation page with an endless 
circle, your Internet Explorer may not be properly configured to enable Active X controls.  

Note: If you are prompted to download the installer file directly, please follow those on-
screen instructions to install pressplay using that method. 

To enable Active X controls: 

 

1. Launch Internet Explorer. 

2. Select Internet Options ... from the Tools drop-down menu.  

3. Select the Security tab. 

4. With the Internet icon selected, click the Custom Level … button. 

5. Under ActiveX controls and plug-ins, make sure that the first section Download signed 
ActiveX controls is set to Prompt.  

6. Check that Run ActiveX controls and plug-ins is set to Enable. 

7. Try the pressplay installation again. 

Note: If you are not able to change your Internet security settings, then Internet Explorer 
security is locked and can only be changed by the network administrator. 

If this does not resolve your issue, it is possible that your version of InstallShield is corrupted. To 
reset your InstallShield: 

 

1. Select Internet Options ... from the Tools drop-down menu of Internet Explorer. 

2. Click the Settings … button. 

3. Click the View Objects … button. 

4. In the window that appears, select a file named InstallShield International Settings Player, 
then right-click and select Remove. 

5. Now try to install pressplay again. 
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R.K.19. I am not able to install the pressplay application, or am having other individualization 
problems (cannot stream or download after installing). 

It is possible that the Windows Media Player upgrade didn’t work during the installation and your 
individualization failed. To upgrade your individualization go to the following site: 

 http://drmlicense.one.microsoft.com/Indivsite/indivit2.htm  

Note: An alternative way to upgrade your individualization is to locate and open the 
WMP_Upgrade.wma file that is typically found in the C:\Program Files\pressplay directory. 
Double-click this file or open it directly from Windows Media Player, and then follow 
instructions. 

R.K.20. When I try to use pressplay, I get an error saying “Windows Media Player 7.1 or above must 
be installed in order to play music” even though I already have WMP 7.1 installed. 

pressplay requires a built-in Windows Media Player file (wmp.ocx) to be present and functioning 
correctly in order to play music through pressplay. If you did not reboot successfully after installing 
Windows Media Player 7.1, or you uninstalled Windows Media Player 7.1 after pressplay was 
installed you might get this error. Note that if this occurs, Windows Media Player 7.1 may function 
correctly, but programs that depend on the wmp.ocx file (such as pressplay) may experience 
problems. 

If the wmp.ocx file is missing, then you will need to re-install Windows Media Player 7.1 To find out 
if the file is missing, use the Windows Search tool to locate the file. The wmp.ocx file is typically 
found in the following directories: 

• Windows 98/ME—C:\\Windows\system 

• Windows 2000—C:\\WINNT\System32 

• Windows XP—C:\\Windows\System32 

If the wmp.ocx file is present and pressplay is still giving the stated error, then first try rebooting 
your system. If after rebooting the problem still persists, then uninstall and reinstall Windows Media 
Player 7.1 and allow the system to reboot when prompted. 

If the problem still persists after doing all of the above, then the system may not be registering the 
wmp.ocx file correctly. To register the file manually, go through the following procedure: 

 

1. Close pressplay. 

2. Open a Dos prompt window. To do this click Start !!!! Run … and in the window that displays, 
type command (or cmd), and then click OK. 

3. Change directories to C:\Windows\System by typing: 

 cd \windows\system  

and then press Enter. 
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4. To unregister the file, type: 

regsvr32 /u wmp.ocx  

and then Enter. A dialog should appear, stating “DLLUnregisterServer in wmp.ocx 
succeeded.”  

5. To re-register the file, type: 

regsvr32 wmp.ocx 

and then press Enter. A dialog should appear, stating “DLLRegisterServer in wmp.ocx 
succeeded.”  

6. Click the OK button in the dialog box. 

7. Type:  

Exit  

in the command window, and then Enter. 

8. Launch pressplay and confirm that it now works correctly. 

R.K.21. I get a virus warning during installation. 

Some virus protection software, such as Norton AntiVirus, may detect InstallShield as a virus. 
InstallShield is a common installation program used to download and install pressplay and is not a 
virus. For more information and to get an updated to your Norton AntiVirus software, go to: 

www.norton.com  

R.K.22. Is it possible to get viruses from pressplay?  

pressplay does not use scripting languages on our Web pages that are capable of any viral 
activity. The only programs that we deliver to your PC are the pressplay application itself and the 
other components that form the installation. These programs are checked for viruses before we 
generate the installation. In addition, to make sure that no one hacks our installation and replaces it 
with one that contains a virus, we have a certificate assigned to us by VeriSign that permits us to 
sign our installation files. We do this with every installation we generate and you will see evidence 
of this when you start the install. All other data and information delivered by pressplay is in such a 
format that it cannot carry viruses. 

R.K.23. DRM cannot be Individualized/Customer receives “your membership must be updated” 
errors that cannot be resolved by other means (Windows ME).  

<< THIS PROCEDURE SHOULD ONLY BE PERFORMED BY OR UNDER THE 
AUTHORIZATION OF PRESSPLAY SECONDLINE>> 

Unfortunately, the problem that your computer is experiencing is due to a known issue with the 
Digital Rights Management (DRM) component of Window’s Media Player. This issue is most 
prevalent in Windows ME and is rarely seen in other Microsoft operating systems. A broken DRM 
not only prevents you from using pressplay, but also will not allow you to play downloaded media 
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files from http://Windowsmedia.com or other Web sites or services that use secure .wma audio 
files or secure .wmv video files. Once a problem is discovered with the DRM, the only available 
option (other then reinstalling your operating system) is to reset the DRM component. Although 
resetting the DRM is usually successful, there are some inherent risks that we must warn you 
about. 

First caveat, if you have licenses on your computer for secure media files (either music or video 
files) that you downloaded or copied from a CD using Windows Media Player, you will lose these 
licenses and will not be able to play these media files again. If you have these types of files present 
on your computer, you will have to download the media files or copy from your CDs again. 

Second caveat, if the reset procedure does not correct the functionality of the DRM, then we can 
only refer you to Microsoft technical support for further assistance. Window’s Media Player support 
can be reached at 425.635.3311 or on the web at http://support.microsoft.com.  

To continue with the DRM reset process, please follow the instructions outlined below.  You will 
need to be online to complete these steps. 

 

1. Please close Windows Media Player and pressplay (if installed). 

2. Go to http://admin.pressplay.com/client/drmreset/install.html by either clicking on this link or 
copying the URL into the address bar of Internet Explorer. 

3. Follow the on-screen instructions to continue with the reset process. Please note that the 
application does not have a progress bar or hourglass, so please be patient and allow the 
application to finish. 

4. After the reset process is complete, you will need to do one of two things: 

a. Install pressplay if the previous installation failed to complete OR 

b. If pressplay is already installed, open Windows Media Player. Select the File drop-down 
menu and choose Open.  Browse to the C:\Program Files\pressplay directory and play the 
file named WMP_Upgrade.wma. Allow the security upgrade to complete by following the 
instructions that are displayed in the media player. 

R.K.24. When installing pressplay, I get the message "ERROR LOADING TYPE LIBRARY/DLL, The 
InstallShield Engine (iKernel.exe) could not be launched" or I am having other InstallShield 
issues. 

According to InstallShield (the software pressplay uses to perform the installation), the issue can be 
fixed by trying the steps below:  

Note: After each step, try running the setup program. If it still does not work then try the 
next step. 

 

1. If you are trying to install to a Windows 98 machine, download and run Dcom98.exe from the 
following site:  

http://www.microsoft.com/com/dcom/dcom98/download.asp.  

2. Clean out the Temp directory (located in C:\Windows\Temp). 
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3. Delete the \Program Files\Common Files\InstallShield\engine folder (it is usually in your 
C:\Program Files directory) and then rerun the installation for the application you are trying to 
install. 

4. Go to your \Common Files\InstallShield\engine\6\Intel 32 directory (it is usually in your 
C:\Program Files directory) and delete the Intel 32 directory that contains the IKernel.exe 
file. Then download the following: 

http://support.installshield.com/kb/files/Q105097/IkernelSetup.exe.  

For other InstallShield errors such as: 

• Error extracting support files 

• Error installing Ikernel.exe (0x any number) 

• Access is denied 

Try solutions outlined in the following article from InstallShield's knowledge-base: 

http://support.installshield.com/kb/view.asp??pcode=ALL&articleid=Q104985  

 

R.K.25. Member did not complete registration successfully (zero subscriptions display in 
customer's subscription history). 

<<< IF THE CUSTOMER SPECIFIES WHICH ACCOUNT THEY WOULD LIKE OR CONTACT 
BY PHONE, THEN THE CCR CAN USE THE CST TO ACTIVATE THE MEMBERSHIP PLAN 
THAT THE CUSTOMER IS TRYING TO SIGN UP FOR, AND THEN NOTIFY THE CUSTOMER 
THAT THE MEMBERSHIP PLAN WAS ACTIVATED. IF REGISTRATION FAILED 

IF THE CUSTOMER DOES NOT SPECIFY THE MEMBERSHIP PLAN THEY WERE TRYING 
TO SIGN UP FOR, OR IT IS NOT CLEAR 

We are sorry, but it appears that your pressplay registration process did not complete successfully. 
We could not locate an active pressplay subscription using the information you provided. Please 
contact us at help@support.pressplay.com or 888.660.2265 and specify which membership plan 
you would like to sign up for and we can activate your pressplay subscription for you. 

To register for pressplay, please return to the affiliate site through which you registered.  

pressplay is offered through our affiliates or directly through Windows Media Player 9 Series.  
Currently, our affiliates include: 

• Yahoo!  < http://music.yahoo.com/ > 

• MSN Music  < http://music.msn.com/ > 

• Roxio  < http://www.roxio.com/ >     

• MP3.com  < http://www.mp3.com/ >  
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• Sony’s Musiclub  < http://www.musiclub.sonystyle.com/ >  

• Gateway Music Vault < http://www.gateway.com > 

• Rio < http://www.sonicblue.com > 

• pressplay (generic) < http://www.pressplay.com >  

If you wish to use the same member name and password, follow the I am already a member! link 
at the top of the registration form. Otherwise, follow the instructions to register and please do not 
hesitate to contact us again if you have any questions. 

If you have Windows Media Player 9 Series, then you can sign up for pressplay through the link on 
the Services menu option. To get the 9 Series player, go to:  

http://windowsmedia.microsoft.com/download/download.asp 

R.K.26. How do I uninstall pressplay? 

To uninstall the pressplay application: 

 

1. Close the pressplay application.  

2. Choose Start > Settings > Control Panel > Add/Remove Programs.  

3. Click on pressplay from the list of programs, then click Change/Remove.  

4. Click the Remove radio button and then Next. 

5. Follow the instructions until it is complete. 

R.K.27. How do I know what version of pressplay I am using? 

<CLIENT>  You can find out what the version number is by checking the at the bottom of your 
player to the left of the volume control.   

<9 SERIES>  Click OPTIONS/HELP from the HOME tab. Click the About link. 

R.K.28. Client installation issues that cannot be resolved by other means.  

We apologize for the installation issue you are experiencing. To resolve your issue we suggest you 
follow this procedure to download and install pressplay: 

 

1. Please click on the following link or copy/paste it into the address bar of Internet Explorer: 

http://admin.pressplay.com/client/pressplay_installer.exe 

2. When the download screen appears, please save the installer to your desktop. 

3. Locate the pressplay_installer.exe file on your desktop. 
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4. Double-click on the pressplay_installer.exe file to begin installation. 

5. Follow the instructions to install pressplay. 

R.K.29. <GATEWAY ONLY> How do I start my Gateway Music Vault by pressplay membership? 

Once you receive and set up your new Gateway computer, launch pressplay by clicking Start > 
Programs > pressplay. The first time you launch pressplay, you will be presented with a short 
overview followed by our registration pages. Please fill in all of the required fields. Once you 
complete the registration, log in and experience pressplay! 

R.K.30. <GATEWAY ONLY> I tried to play a track on my PC and it said I had to register for 
pressplay.  Do I have to register? 

In order to listen to your pressplay downloads that came with your Gateway Music Vault, you need 
to register for pressplay.  To register, click Start > Programs > pressplay. The first time you 
launch pressplay, you will be presented with a short overview followed by our registration pages. 
Please fill in all of the required fields. Once you complete the registration, sign in and experience 
pressplay! 

R.K.31. <GATEWAY ONLY> Why do I have to register for the Gateway Music Vault by pressplay 
free trial?  

Registering eliminates the need for additional registration at the end of your trial period and allows 
you to purchase additional packs of Portable Downloads quickly and easily.  Also, by registering 
pressplay can keep you up to date with the latest releases and exclusives in the service. You can 
cancel your pressplay membership anytime before the end of your free trial and your credit card 
will not be billed by pressplay. 

R.K.32. <GATEWAY ONLY> Do I need to sign up for pressplay in order to listen to the pressplay 
tracks that came pre-loaded with my Mega Pack or Genre Pack memberships?  

In order to play the pressplay tracks that come pre-loaded with your Gateway Music Vault, you 
need to register for pressplay. You will be prompted to register when you first launch pressplay by 
clicking Start > Programs > pressplay.  

R.K.33. <GATEWAY ONLY> If I already have a pressplay account and get a Gateway Music PC, do I 
need to register?  

If you already have a pressplay membership and you purchase a Gateway Music PC, you do not 
need to register again. When you are prompted to sign up you can click the I am already a 
member! link in the upper right corner. If you have a Mega Pack or Genre Pack membership with 
Gateway Music Vault, you will be able to access your pre-loaded downloads, but you will not 
receive your trial period unless you register under your Gateway Music Vault membership plan. 
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6 Membership 

6.1 Membership FAQs 

M.F.1. What are the available pressplay membership plans? 

 

• pressplay Unlimited—unlimited streaming and downloading for $9.95 per month 

• pressplay Unlimited Plus—unlimited streaming and downloading and 10 Portable 
Downloads a month for $17.95 per month 

• pressplay Annual Plus—unlimited streaming and downloading for one year and 120 Portable 
Downloads NOW. A $14.95 per month value (payable as $180 up front). 

In addition, Portable Download Packs are always available. The 5-pack of Portable Downloads is 
$5.95, the 10-pack is $9.95 and the 20-pack is $18.95.   

M.F.2. I am not able to sign in to pressplay. 

Here are some initial things to consider: 

• Remember that passwords are case-sensitive. Verify that you do not have the Caps Lock key 
on, and try re-typing the password. 

• Verify that you are signing in under the correct affiliate. If the affiliate listed on the sign-in page 
is not the affiliate you signed up with, then click the link to switch to another account, and then 
choose the correct affiliate to sign-in. 

• For pressplay on MSN Music members, verify that you are using the correct MSN .NET 
Passport sign-in (e-mail address) and NOT your pressplay member name to sign in. If you 
can’t remember your MSN .NET Passport sign-in or password, contact MSN for assistance: 

https://memberservices.passport.com/  

If you are still unable to sign in, then try calling a pressplay Customer Care representative at 
888.660.2265 and provide us with your sign-in and password so we can verify whether the issue is 
with your specific sign-in, or whether it is an issue with your computer configuration. 

M.F.3. Can I access my existing pressplay membership through Windows Media Player 9 Series? 

Absolutely! You can listen to your pressplay membership on either versions of pressplay. To 
access your existing pressplay membership through Windows Media Player 9 Series: 

 

1. Install the 9 Series player (this can be obtained at 
http://windowsmedia.microsoft.com/download/download.asp).  

2. Click the Services button on the 9 Series player. 
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3. Follow the pressplay link. 

4. Follow the “I am already a member!” link.    

Note: The different versions of pressplay are treated as separate installations and you will 
need to perform a Sync/Restore to listen to your downloads on the other version. 

M.F.4. How do I cancel my pressplay membership? 

If you wish to cancel your membership: 

 

1. <CLIENT>  Select Account Status from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Account Status. 

2. Click on the To cancel your membership link. 

3. Review the terms of cancellation and click CONTINUE. 

Your membership will be terminated at the end of the billing period you paid through. 

M.F.5. How can I reactivate a previously canceled membership? 

To reactivate a canceled membership, sign in to pressplay through the same affiliate with the same 
member name and password that you had before. You should receive a "Welcome Back to 
pressplay" page with a link to reactivate your account. If you reactivate your membership with 
the same member name/password within 6 months from when you canceled, you can regain 
access to your downloads using the Sync/Restore feature.  

Note: If you need any help during the reactivation process, please feel free to contact 
pressplay Customer Care at 888.660.2265 and we can reactivate your membership for 
you. 

If you no longer have pressplay installed on your computer, you can first download the pressplay 
application from one of the following sites (depending on which affiliate you originally signed up 
through): 

• pressplay on MSN Music members go to the following URL: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=9 

• pressplay on Yahoo! members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=10 

• Roxio pressplay members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=11 

• pressplay on MP3.com members go to: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=36 

• pressplay on Sony's Musiclub members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=87 
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• pressplay connect members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=88 

• Gateway Music Vault by pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=123  

• Rio pressplay members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=143 

• pressplay (generic) members click here: 
http://admin.pressplay.com/duet/registration/r_member_download.html?reg=1&affiliate_id=7 

Once you download the pressplay application, sign in with the same member name and password 
and you should see a link to reactivate your account. 

<9 SERIES>  If you signed up for pressplay through Windows Media Player 9 Series or wish to 
use pressplay through the 9 Series player: 

 

1. Install the 9 Series player. This can be obtained at: 
http://windowsmedia.microsoft.com/download/download.asp if you do not have it already. 

2. Click the Services button on the 9 Series player. 

3. Follow the pressplay link. 

4. Follow the “I am already a member!” link.    

M.F.6. If I cancel, do I get to keep my downloads and/or Portable Downloads?  

If you choose to cancel your pressplay membership, you get to keep the Portable Downloads you 
acquired. However, you will lose the ability to play the regular downloads at the end of the period 
you paid through.  

If you decide to come back to pressplay within six months, you can regain access to your entire 
download collection (using the Sync/Restore feature) after you sign up again using the same 
member name and password. 

M.F.7. How do I upgrade my pressplay membership plan? 

If you wish to upgrade your membership plan to either the pressplay Unlimited Plus or pressplay 
Annual Plus membership plan: 

 

1. <CLIENT>  Select Account Status from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Account Status. 

2. Select CHANGE MEMBERSHIP PLAN. 

3. Select a membership plan that best suits your needs. 

4. Review the details of the offer and click SUBMIT to accept. 



pressplay K-base  Membership 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 36 
 

Note:  If you upgrade your membership plan, the new plan will take effect immediately and 
you will be billed the difference in price between the plans. If you upgrade from pressplay 
Unlimited Plus to pressplay Annual Plus, the difference in the Portable Download 
credits between the plans will be added to your current total. 

M.F.8. How can I downgrade my membership plan to a pressplay Unlimited or pressplay Unlimited 
Plus? 

If you wish to downgrade your membership plan: 

 

1. <CLIENT>  Select Account Status from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Account Status. 

2. Select CHANGE MEMBERSHIP PLAN. 

3. Select a membership plan that best suits your needs. 

4. Review the details of the offer and click SUBMIT to accept. 

Note:  If you downgrade your membership plan, you will not be charged the new rate until 
the beginning of the next billing cycle. The new Portable Download amounts will not be 
effective until your next billing cycle.  

M.F.9. If I downgrade, upgrade or reactivate another membership plan, do I get the 3-day free trial? 

The 3-day free trial is only available once, when you initially sign up. If you downgrade or upgrade 
to another membership plan, the 3-day free trial is not included. 

M.F.10. Why did I receive a Payment Decline Notice?  

You received this notice because we were unable to process your membership based on the billing 
information provided during registration. To update your billing information: 

 

1. Sign in to pressplay. 

2. <CLIENT>  Choose Member Information from the My Account drop-down menu along the 
top. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Member 
Information. 

3. Click the EDIT button. 

4. Verify the credit card information, including the name on card, card type, expiration date, billing 
address, city, zip code, and country. 

5. Carefully re-type the card number. 

6. Click the UPDATE MEMBER INFO button. 
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Note: pressplay currently accepts Visa, Mastercard, and American Express credit cards. 
Debit or ATM cards are not currently accepted.  

Note: For your security, pressplay uses address verification. The address listed must be 
valid and correspond to the billing address for your credit card. Currently, the address 
must also reside within the United States. 

For security reasons, we ask that you do not send credit card information via e-mail, but if you need 
any assistance with correcting this issue please call Customer Care at 888.660.2265. 

M.F.11. How do I switch my billing credit card? 

The Member Information page under my account contains billing information that you entered 
when you registered. 

To update this information: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Member 
Information. 

2. Click the EDIT button. 

3. Verify the name on card, and change if necessary. 

4. Select a new card type using the drop-down menu. 

5. Enter the new card number. 

6. Update the expiration date using the drop-down menus. 

7. Verify that all the other billing information is correct. 

8. After you have made changes, click UPDATE MEMBER INFO to post the changes.  

Note: If your credit card information is altered so the card number or expiration is not valid, 
then pressplay will be unable to process your membership. 

M.F.12. Who do I contact if I have a billing issue regarding my credit card? Who do I contact if I 
believe I was billed in error?  

Contact pressplay Customer Care using the help request forms available from Help menu or by 
calling 888.660.2265. A Customer Care representative can provide an explanation of your charges 
for you to verify. 

M.F.13. I suspect that an unauthorized user is accessing my pressplay account, what do I do? 

If you suspect that your pressplay account was accessed by an unauthorized user, contact 
pressplay Customer Care at 888.660.2265. 
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M.F.14. How do I change the member name that is visible to others?  

Your member name is the unique name you chose when you registered and cannot be changed. 

M.F.15. Can I share my pressplay membership with others? 

Your pressplay membership is for your personal use only. If you give others access to your 
pressplay account, keep in mind that only one concurrent user is allowed on your account at a time 
and the tracks they make Portable Downloads will count against your membership plan. 

M.F.16. How do I switch the member name that is currently signed in? 

If you share a computer with another pressplay member, it’s possible that they may already be 
signed in to pressplay when you sit down to use the computer. To switch to your personal 
collection of streams or downloads: 

 

1. <CLIENT>  Select Switch Member Name from the File menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on the Switch 
Member Name link. 

2. Click OK in the confirmation dialog box. 

A Web page is presented that gives you three paths for signing in.  

3. Choose the appropriate path and sign in using your member name and password.   

M.F.17. Can I switch member names while I am offline? 

No, you must be signed in to switch member names. 

M.F.18. I used up all the Portable Downloads in my membership plan before my membership period 
was over—is there a way I can get more Portable Downloads? 

pressplay offers all members and trial participants the ability to purchase additional Portable 
Download packs to supplement your membership plan. You can purchase a 5-pack of Portable 
Downloads for $5.95, a 10-pack for $9.95, or a 20-pack for $18.95. These Portable Download pack 
credits are good for as long as you are an active member.  

If you have a pressplay Unlimited or Unlimited Plus membership plan, you can also consider 
upgrading to a pressplay Annual Plus membership plan that provides 120 Portable Downloads for 
the year, all available on day one of your membership. 

M.F.19. How do I purchase a Portable Download pack? 

To purchase a Portable Download pack: 

 

1. <CLIENT>  Select Account Status from the My Account drop-down menu. 
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<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on Account Status. 

2. Click the link that says “Click here to buy more Portable Downloads!” . 

3. Select the number of Portable Downloads you wish to purchase. 

4. Review the details of the offer and click SUBMIT to accept. 

Portable Download credits from your 5-, 10-, or 20-packs will not expire as long as you are a 
pressplay member. 

M.F.20. If I have Portable Download credits from my membership plan and also purchase a Portable 
Download pack, which credits will be used up first? 

The Portable Download credits allotted from your membership plan will be used up first. Once your 
membership Portable Download credits have been used up, then your Portable Download credits 
from your 5-, 10-, or 20-pack will be decremented. 

M.F.21. What is the Member Get Member promotion? 

The Member Get Member program provides a convenient way to refer friends and family to 
pressplay and also get rewarded at the same time! For each person that becomes a paid member 
from your referral, you will receive 10 free Portable Downloads. In addition, if your friend signs up 
by your Member Get Member referral, they will also receive 10 free Portable Downloads. Look for 
Member get Member promotional links on the HOME page and other locations throughout 
pressplay. 

M.F.22. How can I recommend pressplay to a friend or family member and get rewarded? 

The Member Get Member promotion allows you to share pressplay with your friends and families, 
and also get rewarded for referrals that sign up. Here’s how it works: 

5. Click the Member Get Member link. These promotional links are typically available from the 
HOME page or other locations throughout pressplay.  

6. Type in the e-mail addresses of friends and family members that you want to share pressplay 
with in the Friend’s E-mail field. If you are typing in multiple e-mail addresses, separate them 
with commas.  

7. Type in your name and any personalized comments that you wish to add. 

8. Click the Submit button. 

An e-mail will be sent to the specified e-mail addresses inviting these people to sign up for 
pressplay. Once they sign up from the link in that e-mail, we will send you an e-mail notifying you 
that they joined. For each person that signs up from your referral, you will receive 10 free Portable 
Downloads. The 10 Portable Downloads will be credited to your account at the beginning of the 
next billing period. In addition, if your friend signs up by your Member Get Member referral, they will 
also receive 10 free Portable Downloads!  
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6.2 Membership K-base Only 

M.K.1. I forgot my password or member name. What do I do? 

The password and member name recovery process varies with each affiliate: 

• pressplay on MSN Music members use the MSN .NET Passport to sign in. The .NET 
Passport e-mail address or password can be changed by following the instructions on the 
.NET Passport sign-in, or by going to the following URL: 
https://memberservices.passport.com/ppsecure/MSRV_ResetPW.asp  

• All other pressplay affiliate members use the integrated pressplay sign-in. Please contact us 
again and provide your e-mail address supplied during registration, member name, and 
affiliate so we can reset your password or recover your member name   

M.K.2. I will not be using my pressplay membership for an extended period, can I cancel and then 
reactivate the same membership at a later date? 

As long as you reactivate your membership with the same member name that you originally signed 
up with, you can regain access to your previous downloads using the Sync/Restore feature. 

M.K.3. If I cancel partway through a billing cycle, do I get charged for the whole period? 

After you register and make your payment for the pressplay service, you agree to a monthly or 
annual membership up front, depending on the plan you choose. If you cancel at any time during 
this billing cycle, you will receive the pressplay service until the end of that billing cycle, and will be 
charged for that period. 

M.K.4. Where does my membership fee go—how much goes to the artist, how much to the record 
label, etc.? 

pressplay has agreements with the record labels under which pressplay compensates the labels 
for the use of the music in the pressplay service. The labels then in turn compensate the artists 
dependent on the terms of the individual artist contracts. 

M.K.5. Does the artist get royalties per stream, or per membership? 

This depends on the terms of the artist contract between the record label and the artist. 

M.K.6. Who handles your subscription management? 

pressplay employs VUNet USA Technologies as a back-end technology provider, which includes 
subscription management. 
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M.K.7. When I try to stream or download music, I get a message that says “we were unable to 
update your membership”. 

Here are some initial things to check: 

• Verify that the system date on your computer is correct or didn’t accidentally get changed. If 
the date is not correct, update the date and try again. 

• It is possible that the Windows Media Player upgrade didn’t work during the installation. Locate 
the WMP_Upgrade.wma file in the pressplay directory and double-click on it to upgrade the 
individualization. Try again after upgrading.  

If you are still having problems, please contact us again. 

M.K.8. I get a sign-in error that states “Either there is a problem with your Internet connection or 
the server is not available. Please check your connection and try again”. 

Verify that you have an active Internet connection by launching your Internet Explorer and seeing if 
you can access other Web sites. If you are able to access other sites, then verify your Internet 
settings: 

 

1. Select Internet Options…from the Tools drop-down menu. 

2. Go to the Connections tab and verify the information. 

3. If you are using a proxy server, then click the LAN Settings …button and make sure the proxy 
server address is correct. If you are not using a proxy server, make sure this box is not 
selected. Consult your Network Administrator if you are unsure. 

4. On the Advanced Tab, make sure the Use SSL 2.0 box is checked. 

M.K.9. Why does it appear that my credit card is being charged multiple times?  

When your pressplay membership is set to rollover into a new payment period, pressplay sends a 
request to your credit card for authorization. Even though this is a standard procedure, some banks 
or financial institutions may perceive these authorization attempts as pending charges, when in fact 
they are merely attempts to verify the credit card and authorize the charges.  

If the authorization is declined, pressplay will send a payment decline notice to the e-mail address 
you provided during registration with instructions to correct your billing information. pressplay may 
periodically send an authorization request to your account to see if the billing information was 
corrected. It is important to note that these are merely authorization attempts and not actual 
charges. They will disappear from you account and only one charge (if validated) will appear on 
your final statement. 

To remedy the situation, verify and update your billing information: 

 

1. Sign in to pressplay. 

2. Choose Member Information from the My Account drop-down menu along the top. 
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3. Click the EDIT button. 

4. Verify the credit card information, including the name on card, card type, and expiration 
date. Verify that the card is NOT a debit, or ATM card but a credit card. Try another credit card 
if you have one available. 

5. Verify the billing address, city, zip code, and country. Verify that this address corresponds 
to the credit card you are using. 

6. Carefully re-type the card number. 

7. Click the UPDATE MEMBER INFO button. 

Note: pressplay currently accepts Visa, Mastercard, and American Express credit cards. 
Debit or ATM cards are not currently accepted.  

Note: For your security, pressplay uses address verification. The address listed must be 
valid and correspond to the billing address for your credit card. Currently, the address 
must also reside within the United States. 

If you are still having problems, please contact us with details of your issue. Due to the sensitive 
nature of billing information, we ask that you do not send credit card information via e-mail, but if 
you need any assistance with correcting this issue please call Customer Care at 888.660.2265.  

M.K.10. I want to cancel/How do I cancel? (within 3-day trial) 

We are sorry that you have decided to cancel your pressplay membership. Your trial membership 
has been canceled and you will not be billed. 

If you would ever like to reactivate your pressplay membership in the future, you can do so by 
signing up again through the same pressplay affiliate (follow the "I am already a member!" link) and 
use the same member name and password. If you reactivate within six months, you will regain 
access to all of your existing downloads. 

M.K.11. I want to cancel / How do I cancel?  

We are sorry to hear you want to cancel. If there is any particular issue that we can help you with, 
please let us know.   

If you wish to cancel your membership, you may do so by following these steps: 

 

1. Sign in to pressplay. 

2. <CLIENT>  Select Account Status from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab and click the Account Status link. 

3. Click on the "To cancel your membership" link. 

4. Review the terms of cancellation and click CONTINUE. 



pressplay K-base  Membership 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 43 
 

If you would ever like to reactivate your pressplay membership in the future, you can do so by 
signing up again through the same pressplay affiliate (follow the “I am already a member!” link) and 
use the same member name and password. If you reactivate within six months, you will regain 
access to all of your existing downloads.  

M.K.12. Cancellation confirmations for cancellations through CST (within three days of DPT). 

We are sorry that you have decided to cancel your pressplay membership. Your membership has 
been canceled. At the end of your membership period you will no longer be able to access 
pressplay. 

If you would ever like to reactivate your pressplay membership in the future, you can do so by 
signing up again through the same pressplay affiliate (follow the “I am already a member!” link) and 
use the same member name and password. If you reactivate within six months, you will regain 
access to all of your existing downloads. 

M.K.13. Refund Denial Response.  

According to the pressplay terms and conditions, refunds are only issued under extenuating 
circumstances, such as the inability to use the service. Our records indicate that you have 
successfully accessed and used your pressplay membership during this current subscription 
period, and consequently we are unable to issue you a refund.  

Thank you in advance for your understanding in this matter. 

M.K.14. How long will it be before I get a refund? 

Refunds are typically processed in 48 to 72 hours, but may take longer depending on the issue. 
Please check your credit card account and notify us again in 7-10 days if it appears your refund 
has not been processed. 

M.K.15. Billing discrepancies. 

<NOTE: BEFORE SENDING OUT THIS TEMPLATE REQUESTING A COPY OF THE 
BILLING STATEMENT, THE CCR SHOULD VERIFY THAT THESE ARE NOT 
AUTHORIZATION ATTEMPTS> 

Thank you for contacting pressplay with your billing inquiry. Unfortunately, our billing records do not 
reflect the claim you are making. Note that as part of the normal billing process, pressplay may 
send out authorization requests to your credit card. These are not actual charges and will be 
subsequently voided by the time you get your final statement. If you have verified that these are not 
authorization requests, but actual charges, then our accounting department will need some 
additional information to process your refund. 

Please send us a copy of your final printed credit card statement (not your online running balance), 
showing the charges you are disputing, as well as a brief description of your discrepancy. Your 
credit card number should also be on the statement so we can correlate the charges. Please fax 
this information to pressplay Customer Care at 402.577.3291.  
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We apologize for any inconvenience and assure you that we will look into this matter as soon as 
possible. Upon receipt of your credit card statement showing these charges, you should hear a 
reply from us within 2-3 business days. 

M.K.16. Payment rejected because of "Credit Floor" or "Insufficient Funds" error in CST. 

We are sorry, but we are unable to process your payment using the credit card you provided. 
Please check the account to verify that you have sufficient funds to accommodate the charge, or 
try another credit card. 

M.K.17. Password Recovery follow-up Template. 

We have processed your password recovery request and have sent it to the e-mail address you 
provided during registration. Your member name is also in this e-mail with instructions on how to 
sign-in with this member name and password. If you did not receive the e-mail with your new 
password, or have any other questions, please let us know. 

M.K.18. Request more information to access account. 

In order for us to access your account, we need some additional information. Please reply with 
your pressplay member name, e-mail address used during registration, and the affiliate you 
registered through (Yahoo!, Roxio, MSN Music, MP3.com, Sony's Musiclub, Gateway Music Vault, 
Rio, pressplay connect, or pressplay (generic or for Windows Media Player 9 Series)). After we 
receive this information, we will process your help request.  

M.K.19. Automatic MSN sign-in failure due to multiple .NET Passports on Windows XP. 

If you have more than one MSN .NET Passport account and you are using the .NET Passport 
automatic sign-in feature on Windows XP, then it is possible that the automatic sign-in is bypassing 
the pressplay sign-in and not allowing you to enter the correct .NET Passport. To correct this issue 
you must either disable the automatic sign-in feature or use the .NET Passport sign-in that you 
used during pressplay registration. 

To disable or change the .NET Passport auto sign-in for Windows XP Home: 

 

1. Click Start > Settings >Control Panel from the Start menu. 

2. Click on User Accounts. 

3. In the next screen, click on the user account that you are currently using. If Windows XP does 
not ask you for a user account when it boots up, then choose the Administrator account. 

4. Click on Change my .NET passport. 

5. Click on Use a different .NET passport. 

6. Follow the instructions presented by the .NET passport wizard to add the .NET passport email 
address used to register for pressplay. 

Note: This does not delete the .NET Passport account, but merely removes it as the XP 
stored .NET Passport account that is used for the automatic sign-in feature. 
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7. When complete, launch pressplay and you should now be prompted for a .NET Passport sign-
in. 

At this point, if you want to use this e-mail address as your default .NET Passport account for 
automatic sign-in, click the “Sign me in automatically” checkbox. 

Note: This will be a recurring issue if you set another .NET Passport account (other than 
the one you used to register with pressplay) as the default account for automatic sign-in. 

To disable or change the .NET Passport auto sign-in for Windows XP Professional: 

 

1. Click Start > Settings >Control Panel from the Start menu. 

2. Click on User Accounts. 

3. In the dialog box that displays, click on the Advanced tab. 

4. Click on the Manage Passwords button. 

5. Highlight your .NET Passport e-mail address and click the Remove button.  

6. Sign in to pressplay and you should now be prompted for a .NET Passport sign-in.  

M.K.20. <GATEWAY ONLY> What is included in my Gateway Music Vault by pressplay 
membership?  

This depends on the membership plan you chose when you purchased your Gateway Music 
PC. If you did not specify a membership plan, then you can sign up for the basic 
membership, which includes a free 3-day trial with unlimited streaming and downloading. If 
you specified the Mega or Genre Pack memberships, then these include: 

• Mega Pack—Includes 90 days of unlimited streaming and downloading of the entire pressplay 
catalog and 20 Portable Downloads. In addition, approximately 2,000 hit songs come pre-
loaded on a 40 GB Hard drive. After the 90-day introductory period, this membership will roll 
into the pressplay Unlimited plan (unlimited streaming and downloading for $9.95 per month). 

• Genre Pack—Includes approximately 150 hits specific to your chosen genre pre-loaded on 
your computer. The Genre Pack membership includes 30 days of unlimited streaming and 
downloading of the entire pressplay catalog and 10 Portable Downloads. After the 30-day 
introductory offer, this membership will roll into the pressplay Unlimited plan (unlimited 
streaming and downloading for $9.95 per month). 

M.K.21. <GATEWAY ONLY> When does my Mega Pack or Genre Pack membership plan on 
Gateway Music Vault by pressplay start? 

As soon as you register for the pressplay service, your membership will begin. Whenever you first 
launch pressplay (choose Start > Programs > pressplay) you will be prompted to register in order 
to start your membership. 

M.K.22. <GATEWAY ONLY> How long is my Mega Pack or Genre Pack membership offer good for? 

You will have one year from the purchase date of your Gateway Music PC to initiate your Genre 
Pack or Mega pack memberships on Gateway Music Vault by pressplay.  
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M.K.23. <GATEWAY ONLY> Can I sign up for the Gateway Music Vault by pressplay Mega Pack or 
Genre Pack membership plan if I did not select the offer when I purchased the Gateway 
Music PC, or if I do not have a Gateway Music PC? 

The Mega Pack and Genre Pack memberships on Gateway Music Vault by pressplay are 
exclusive promotions offered only when you purchase a Gateway Music PC. Currently, the Mega 
Pack and Genre Pack offers are only available if you choose this option upon purchase of your 
Gateway consumer desktop PC.  

To register for the basic membership, simply launch pressplay (select Start > Programs > 
pressplay) and register when prompted. If your PC did not come with pressplay pre-installed, you 
can sign up for pressplay at www.gateway.com/pressplay.   

M.K.24. <CLIENT ONLY> What does the LISTEN OFFLINE button do at sign-in? 

If you select the LISTEN OFFLINE option during sign-in, you will be able to play your downloads, 
create playlists, and perform other functions which do not require you to be signed in to your 
account. If you attempt to perform other actions such as streaming music or updating your account 
information, you will be prompted to sign in. 

7 Finding Music and Content 

7.1 Finding Music FAQs 

F.F.1. How do I search for content in the pressplay catalog? 

A search for artists, albums or tracks, can be performed from the FIND MUSIC tab: 

 

1. Click the FIND MUSIC tab and choose the search type as Artist, Album, or Track from the 
drop-down list. 

2. Enter the search string in the provided field.  

3. Click the SEARCH button.  

The results display. Consult the pressplay User Guide for more details. 

F.F.2. What determines popularity and the pressplay charts rating? 

The pressplay track popularity ranking is determined by the number of times a track is streamed or 
downloaded in the pressplay service in the prior 14 days. Album popularity is based on the 
cumulative popularity of the tracks on the album in the prior 90 days. Artist popularity is based on 
the average popularity for all the albums by that artist in the pressplay service. 

F.F.3. Why isn’t (a specific artist) in your catalog? 
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pressplay strives to have the most comprehensive library of online music available to members. 
We are continually working on signing new agreements with content license holders to make our 
catalog even stronger. If we are not currently licensed for a track, pressplay will recommend 
something that is closely related to the artist or album you are looking for. We are always adding 
new music to the pressplay service, so check back often for your favorite artists.   

F.F.4. I am having problems finding an artist (that is in the pressplay catalog) using the search 
tool? 

pressplay uses the artist, album, and track name spellings as they appear on the album. If your 
search query does not return the artist, album, or track you are looking for (and the artist is 
represented in the pressplay service), then check the spelling. You also might try doing a partial 
string search. In some cases, the actual name may use special characters or spelling. Here are 
examples of names that might give you problems: 

• 98°°°°—this is how this artist appears in the database, so if you tried typing “98 degrees” you 
might not pull up this result. The solution would be to just search for “98”. 

• Blue Öyster Cult—the official artist name requires the special character, so if you searched 
for “blue oyster cult” you might not bring up the result. A search for “blue cult” however, would 
bring up a successful result. 

• Siouxsie & the Banshees—if you tried “Susie and the Banshees” you might not get the 
result, whereas if you tried just “Banshees” you would get the desired result. 

F.F.5. How can I get notified of new pressplay music releases? 

If you would like to be kept up to date with new music releases, make sure you opt-in to receive e-
mail from pressplay. To sign up for pressplay e-mails: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on the Member 
Information link. 

2. Click the EDIT button. 

3.  Scroll down and check the boxes toward the bottom for information updates from pressplay 
and/or the labels. 

4. Click UPDATE MEMBER INFO. 

F.F.6. Which music labels are represented in the pressplay service? 

pressplay members have access to one of the largest online music catalogs, which is constantly 
growing and currently features songs from all five major record companies - Universal Music 
Group, Sony Music Entertainment, EMI Recorded Music, Warner Music Group and BMG - and 
many independent labels. 
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F.F.7. What is the basis for the recommendations in the recommendation engine? 

The recommendations from pressplay’s programming team are based on what other members are 
streaming, downloading, making portable, and searching for. The recommendations are served to 
the right of the search results window and are listed in order of artists with the greatest number of 
similarities to the artist the recommendations are based on. 

Note: Occasionally the number and order of artist recommendations may be affected by 
the number of artists in the pressplay service and the inclusion of suggested new artists 
with no established usage history. 

F.F.8. How can I get recommendations, or find artists that are like another artist? 

To get recommendations for artists that are similar to another artist, search for the artist and view 
the recommendations that display to the right. You can also right-click on an artist from the search 
results and click Recommended Artists from the drop-down menu. 

F.F.9. What does ‘Bookmark Track’ do?  

<CLIENT> When you right-click on a track and choose Bookmark Track, the track is conveniently 
stored under the MY COLLECTION tab in the Bookmarked Tracks folder or under the 
corresponding artist folder. 

<9 SERIES>  When you right-click on a track and choose Bookmark Track, the track is 
conveniently stored under the BOOKMARKED TRACKS tab. You can bookmark both streams 
and downloads, but when you play a bookmarked download from the BOOKMARKED TRACKS 
tab, the streamed version of the track will play. The download version can be accessed from the 9 
Series player Media Library. 

F.F.10. How do I add a track(s) or an album to MY COLLECTION or BOOKMARKED TRACKS? 

<CLIENT>  To add track(s) to MY COLLECTION so they are conveniently accessible, search for 
and select the track(s), then right-click and choose Bookmark Track. The bookmarked tracks will 
now be stored under the MY COLLECTION tab under Bookmarked Tracks. 

<9 SERIES>  To add track(s) to BOOKMARKED TRACKS so they are conveniently accessible, 
search for and select the track(s), then right-click and choose Bookmark Track. If you bookmark a 
download, then the stream version of the track will be accessible from BOOKMARKED TRACKS. 
Tracks that you download or make Portable Downloads are stored in your 9 Series player Media 
Library.  

To add an album to your collection, select BROWSE ARTIST/ALBUM from the FIND MUSIC tab 
and browse for the artist/album. Select the album, right-click, and choose Bookmark Album. All 
the tracks for that album that are featured on pressplay are added to the MY COLLECTION or 
BOOKMARKED TRACKS tab. 

F.F.11. How can I find out what music has recently been added  to pressplay? 

Check the “today: just added to pressplay” section on the home page. This is updated daily with 
highlights of artists and tracks that have been recently added to pressplay. You can also BROWSE 
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NEW ADDITIONS from the FIND MUSIC tab to browse through the content that has been most 
recently added. 

To browse through the content that has been recently added to the pressplay service: 

 

1. Go to the FIND MUSIC tab. 

2. Click on BROWSE NEW ADDITIONS. 

The last 1000 tracks that have been added to the pressplay service display, organized by artist and 
ranked by popularity in the service. You can sort these results alphabetically by artist by clicking on 
the Artists column header. 

Every time you visit this page the results are refreshed, but you can refresh the results manually by 
clicking the REFRESH button. 

F.F.12. How can I find out more information about an artist or album? 

Select an artist and click the artist/album info button (or right-click and choose Artist Info or 
Album Info). Information is provided that includes related artists, a discography, and a biography 
of the artist. Alternatively, you can simply click on the album thumbnail when the track is playing to 
view the artist information. 

F.F.13. How do I block pressplay tracks with explicit content? 

To block tracks with explicit content: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Select OPTIONS/HELP from the HOME tab, and then click the Member 
Information link. 

2. Click the EDIT button. 

3. Check the exclude explicit content box. 

4. After you have made changes, click UPDATE MEMBER INFO to post the changes. 

Note: You also have the option to require a password to turn this block off. To set this 
password, click on the provided link below to change the parental control password. 

F.F.14. How do I turn the explicit content block off? 

To gain access to tracks with explicit content: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Select OPTIONS/HELP from the HOME tab, and then click the Member 
Information link. 
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2. Click the EDIT button. 

3. Un-check the exclude explicit content box. 

4. If you have the parental control password set, type in your password in the provided parental 
control password field below.  

5. After you have made changes, click UPDATE MEMBER INFO to post the changes. 

F.F.15. How do I set or change my parental control password for the explicit content block feature?  

To change your parental control password: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Select OPTIONS/HELP from the HOME tab, and then click the Member 
Information link. 

2. Click the EDIT button. 

3. Click on the provided link to change the parental control password below the exclude explicit 
content checkbox. 

4. If you are changing your password, type in the current password. 

5. Type in the new password, and then re-type this same password in the confirm password 
field. 

Note: You cannot use the string “password” for your password. 

6. Click the UPDATE PASSWORD button, and then click OK.  

F.F.16. I get an invalid password error message when I enter my parental control password or I 
cannot remember my password? 

The parental control password is case-sensitive. Verify that you do not have the Caps Lock key 
on, and try re-typing the password.  

Also note that the word “password” is not allowed as a parental control password. If your parental 
control password is “password”, please change it to something else and try again.  

To recover your parental control password, please send an e-mail to help@support.pressplay.com.  

F.F.17. How can I browse through recent or past hits from the Billboard Charts? 

pressplay features Billboard Charts that let you browse the most popular hits from today or relive 
the hits of years past. To view the Billboard charts: 

 

1. Go to the FIND MUSIC tab and click the BILLBOARD CHARTS sub-tab.  

2. From the chart drop-down menu, select the Billboard chart type that you would like to browse. 
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3. From the folders below, select the year and season that you want to view the hits from.  

4. Click the BROWSE button. 

7.2 Finding Music K-base Only  

F.K.1. What determines whether an artist or track is available on pressplay? 

As soon as the record label partners in the pressplay service make tracks available to pressplay, 
we make them available to our members.  

F.K.2. Do you offer music in other languages?  

We do offer some music in other languages, but currently there is not a way to browse by language 
or country. We are working hard to get more international content available in the pressplay 
catalog. 

F.K.3. Why am I getting the “emerging artist” display instead of suggestions for an artist? 

If emerging artists displays when you search for an artist or request recommendations, it means 
that no recommendation associations have been established for this artist yet. As more members 
listen to that artist, recommendations will be added, so check back at a later date. 

F.K.4. Parental control password recovery or change . 

<<<PARENTAL CONTROL PASSWORD REQUESTS ARE FORWARDED TO 
SECONDLINE@PRESSPLAY.COM SO RODNEY, DAVID OR BISWA CAN RECOVER THEM. 
INCLUDE “PARENTAL CONTROL PASSWORD RECOVERY REQUEST” IN THE SUBJECT 
LINE FOR QUICKER PROCESSING. WHEN SECONDLINE RETURNS THE PASSWORD, 
INCLUDE THE FOLLOWING IN THE REPLY BACK. IF THE CUSTOMER REQUESTS A 
PASSWORD CHANGE, ALSO INCLUDE THOSE INSTRUCTIONS.>>> 

Per your request, your parental control password is: 

<PASSWORD> 

Please make a note of this and keep it in a safe place. This password is used to turn off the explicit 
content block.  

F.K.5. How do I turn the parental control password off?  

Once you have set the parental control password, you must continue to use this feature for this 
account. 
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F.K.6. <GATEWAY ONLY> How can I view my selection of Mega Pack or Genre Pack pre-loaded 
tracks? 

To view the content that comes pre-loaded on your Gateway Music PC with the Mega Pack or 
Genre Pack membership, sign in to pressplay and click the MY COLLECTION tab. 

F.K.7. Why is there no genre classification for <Christian, Gospel, New Age, or any other genre 
not in pressplay> in the pressplay system? (KB ONLY) 

The current browse genres we have created are an attempt to concisely classify the music in the 
pressplay catalog. If we do not currently have a specific genre of music, this does not imply that we 
do not have this type of music in the catalog.  

F.K.8. Why are there gaps in the pressplay Billboard Charts? 

Only tracks that are available in the pressplay service will display in the pressplay Billboard Charts. 
There must be at least ten pressplay tracks or three pressplay albums on the Billboard Charts for a 
season in order for that season to display. 

8 Streaming Music 

8.1 Streaming FAQs 

S.F.1. How do I play (stream) a selected track? 

There are three convenient and easy ways to stream a track: 

• Simply double-click on your selection 

• Select the track and press the play button on the music player along the bottom 

• Right-click on the desired track and select Play 

See the pressplay User Guide for more information. 

S.F.2. Which digital music player does pressplay use to stream tracks? 

pressplay uses Windows Media Player to play your pressplay tracks.  

<CLIENT>  If you don’t have the Windows Media Player 9 Series yet, you may want to get the free 
upgrade to improve your streaming performance. 
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S.F.3. What file format and bitrate are the streaming tracks? 

pressplay uses Windows Media Audio for streaming files. The music is streamed at 20, 32, or 96 
Kbps depending on your connection speed: 

• Dial-up—20 Kbps 

• ISDN—32 Kbps 

• Cable/DSL or higher—96 Kbps 

S.F.4. Can I change the playback quality (bitrate) of my streams? How do I change my connection 
speed? 

pressplay determines the bitrate for streams based on your connection speed. This connection 
speed can be maintained separately for each computer you run pressplay on.  

Note: If you do not specify a connection speed, it will use the default setting of 32 Kbps.  

To change your connection speed: 

 

1. <CLIENT> Choose File > Options from the My Account drop-down menu. 

<9 SERIES> Click OPTIONS/HELP from the HOME tab, and then click the Messages link. 

2. Verify that you are on the General tab. 

3. Use the Connection Speed radio buttons to select the configuration appropriate to your 
environment. 

4. Click the OK button. 

Also note that downloads have a higher bitrate (128 Kbps) than streams, so if you desire higher 
fidelity, consider downloading the track. 

S.F.5. My player needs to re-buffer often in the middle of a track, is there a way to adjust this? 

A track should only need to buffer at the beginning of the track. If the track is re-buffering in the 
middle of the track, chances are your connection speed setting does not match your actual 
connection speed, or you are simultaneously performing another bandwidth intensive operation 
such as downloading files.  

Note: If you don’t have the Windows Media Player 9 Series yet, you may want to get the 
free upgrade to improve your streaming performance. The 9 Series player drastically 
reduces the buffering time between songs and re-buffering during playback. 

Note: The connection speed is maintained separately for each computer. 

To change your connection speed: 
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1. <CLIENT>  Choose File > Options from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab, and then click on the Messages 
link.   

2. Verify that you are on the General tab. 

3. Use the Connection Speed radio buttons to select the configuration appropriate to your 
environment. 

4. Click the OK button. 

S.F.6. Do I have to be online to stream a track? 

Because a stream is played directly from pressplay’s central servers, you must have a working 
Internet connection and be signed into pressplay in order to stream a pressplay track. If you 
download a track, you can play it offline. 

S.F.7. How long will a track be available in the pressplay service? 

Most pressplay tracks should be available in the pressplay service indefinitely. In rare 
circumstances, issues may arise that may cause some artists or tracks to be removed from the 
service.  

S.F.8. How does pressplay manage and distribute its streams? 

Stream and download delivery is handled by our back-end technology provider, VUNet USA 
Technologies, through a secure serving infrastructure. 

S.F.9. How do I play an entire album? 

To play an entire album, select BROWSE ARTIST/ALBUM from the FIND MUSIC tab and browse 
for the desired album. Select the album, right-click, and choose Play Album. 

S.F.10. How do I adjust the volume? 

To adjust the volume, click on the slide bar on the player and drag left to decrease the volume, or 
right to increase the volume.  

<CLIENT>  Alternatively, you can press the + button on your numeric keypad to increase the 
volume and the – button to decrease the volume. 

Note: The volume may also be dependent on the system volume on your computer or the 
volume on your speakers.  
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S.F.11. If I use pressplay on more than one computer, can I specify a different connection speed for 
each computer? How do I do this? 

The connection speed is stored locally and only applies to the computer you set it on. If you install 
pressplay on subsequent computers, you can set the connection speed separately for each 
computer.  

Note: If you do not specify a connection speed for the computer you are using, it will use 
the default setting of 32 Kbps. 

<CLIENT> If you need to update your connection speed, select Options from the File drop-down 
menu. On the General tab, adjust the Connection Speed accordingly.  

<WMP9> If you need to update your connection speed, select OPTIONS/HELP from the HOME 
tab and then click the Messages link. On the General tab, adjust the Connection Speed 
accordingly. 

8.2 Streaming K-base Only 

S.K.1. A track I want is not featured on pressplay, how can I request it? 

Submit your request to pressplay Customer Care via the Feedback form on the Help/Customer 
Care pages and it will be forwarded to our music programming team for review. 

S.K.2. I am having problems streaming or downloading. 

It is possible that the Windows Media Player upgrade didn’t work during the installation and your 
individualization failed. To upgrade your individualization go to the following site:  

 http://drmlicense.one.microsoft.com/Indivsite/indivit2.htm  

Note: An alternative way to upgrade your individualization is to locate and open the 
WMP_Upgrade.wma file that is typically found in the C:\Program Files\pressplay directory. 
Double-click this file or open it directly from Windows Media Player, and then follow the 
instructions. 

S.K.3. <CLIENT>  I am still having problems streaming or downloading after updating Windows 
Media Player (corrupted license). 

If you still cannot stream or download pressplay tracks after updating Windows Media Player, then 
you may have a corrupted license. To fix your license: 

 

1. Shut down pressplay. 

2. Go to C:\Program Files\pressplay\bin. 

3. Delete the streamdb.bin file that is in this directory. 

4. Launch pressplay and try streaming or downloading.  
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S.K.4. I am still having problems streaming or downloading after trying initial troubleshooting 
procedures. 

If none of the previous solutions fixed the problem, then follow this procedure to help pressplay 
Customer Care troubleshoot the issue: 

 

1. Launch pressplay.  

2. <CLIENT>  Select Options from the File drop-down menu and go to the Advanced Options 
tab. 

<9 SERIES>  Click OPTIONS/HELP from the HOME tab and click the Advanced link. 

3. Click the Enable Customer Care logging checkbox. 

4. Under Logging Level, select the level recommended to you by Customer Care (either None, 
Errors, Warnings, Events, Info, or Trace). If no level was specified, accept the default of 
Events. 

5. Exit pressplay and then sign back in to start a fresh session. 

6. Try to stream one song and then try to download one song. 

7. Locate the log.txt file in your \\program files\pressplay\bin directory. Send this 
file back to pressplay so we can investigate the issue further. 

8. Important! After this, go back to the Advanced Options page and uncheck the Enable 
Customer Care logging checkbox so it is not selected. This will prevent the log file from 
getting too big and taking up space on your hard drive. 

S.K.5. Member Reports Defective Stream. 

 

1. Stream the track to verify that the track is defective. 

a. If you cannot duplicate the issue, then tell the customer:  

We could not duplicate the issue on our end. Check your Internet connection or minimize 
any other system resources, and try streaming the track again.  

2. If the track is indeed defective, forward the message or report the issue to 
music@pressplay.com. 

3. Send back the following response to the customer: 

Thank you for bringing this to our attention. It has been reported to our music team and will 
be resolved as soon as possible. We hope to have the issue fixed in 4-6 weeks, at which 
time you should be able to stream the corrected version. 
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S.K.6. I get a “track is not available” error when trying to stream. 

<CCR CHECKS TO SEE IF THEY CAN STREAM THE TRACK ON ANOTHER COMPUTER. IF 
THE PROBLEM IS SPECIFIC TO THAT TRACK, THEN REPORT TO SECOND LINE (IF NOT 
ALREADY A KNOWN ISSUE) AND PROVIDE THE FOLLOWING ANSWER:> 

We are sorry for the inconvenience, but this track in no longer available. Please try another track. 
There is a possibility that the unavailability of this track is temporary, so please try to stream it again 
at a later date. 

S.K.7. <CLIENT>  When I try to stream, the player is stuck on “loading” (Windows 98 and ME). 

If you have Windows 98 or ME, a likely cause might be that you have the Use a proxy server box 
checked and no proxy information entered. To correct this: 

 

1. Open Internet Explorer.  

2. Select Internet Options…from the Tools drop-down menu. 

3. Go to the Connections tab. 

4. Click the Lan Settings …button. 

5. Verify the proxy server settings: 

a. If the Use a proxy server box is checked and no information is entered, then unclick the 
box (assuming you are not using a proxy server).  

b. If you are using a proxy server, verify that the proxy server Address and Port is correct. If 
you are not using a proxy server, make sure this box is not selected. Consult your Network 
Administrator if you are unsure. 

6. Restart the stream.  
 

S.K.8. <CLIENT>  I try to play a stream with pressplay and it cycles back to "ready" without ever 
playing (and if I try to play any streams straight from WMP, I get an error that states "Unable 
to access this media, you may not be connected to the network").  

This may indicate that there is a conflict with your ISP software and Windows Media Player that will 
not allow you to stream any tracks (including pressplay tracks). 

To resolve this issue, please follow this procedure to insert the proper Windows Media Player key 
into your registry: 

 

1. Close pressplay and Windows Media Player. 

2. Save the attached file, WMP Stream Fix.txt, to your desktop or elsewhere on your 
computer. 

3.  Locate and rename this file to WMP Stream Fix.reg. 
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4. Double-click on the WMP Stream Fix.reg file. 

5. Click Yes when prompted to confirm the registry change, and then click OK. 

6. Once the registry update has been performed, open pressplay and try streaming a track. 

You should now be able to stream tracks properly. If you are still unable to stream, please let us 
know. 

Note: If the file extension (.txt or .reg) is not visible, then you will have to first 
configure your system to display file extensions. To do this, double-click on the My 
Computer icon on your desktop and then select Tools > Folder Options. Go to the View 
tab and verify that the Hide File Extensions box is not checked. If it is checked, uncheck 
it and select Apply. Now go back to step 3 and rename the file extension from "txt" to 
"reg". 

 

S.K.9. How do I set Windows Media Player to be my default player? 

To set Windows Media Player as your default media player: 

 

1. Select Tools > Options from Windows Media Player. 

2. <CLIENT>  Go to the Formats tab. Under Available File Formats, select Windows Media 
and any other file types that you want played on Windows Media Player. 

<9 SERIES> Go to the File Types tab. Under File Types, select Windows Media and any 
other file types that you want played on Windows Media Player. 

3. Click OK. 

Note: Windows Media Player does not have to be the default media player to use 
pressplay. 

9 Playlist and Radio 

9.1 Playlist and Radio FAQs 

Note: These FAQs for playlist functionality apply mostly to the standalone pressplay 
application. pressplay for Windows Media Player 9 Series uses native 9 Series playlist 
functionality. pressplay on 9 Series users should refer to the 9 Series player help for 
additional information on playlist functionality. Radio pressplay FAQs apply to both 
pressplay for Windows Media Player 9 Series and the standalone pressplay application. 

P.F.1. <CLIENT>  How do I create a playlist? 

 

1. Find and select the tracks you wish to add to your new playlist. To select multiple tracks, hold 
the Ctrl key down while selecting the tracks. You can also select batches of tracks by clicking 
on the first track, holding down the Shift key, and then clicking the last track. 
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2. Click the create new playlist button at the bottom of the screen, or right-click and choose Add 
to New Playlist.  

3. You are then prompted to title your playlist, select a genre, and write a short optional 
description.  

4. Click save playlist. 

Your playlist will now be accessible through the MY COLLECTION tab. See the pressplay User 
Guide for more details. 

P.F.2. <9 SERIES>  How do I create a playlist? 

Before you make playlists with pressplay for Windows Media Player 9 Series, you must first 
download the tracks. To make a playlist with pressplay downloads: 

 

1. Go to the Media Library in the 9 Series player. 

2. Select some tracks to start your playlist (optional).  

3. Click the Playlists button and then select New Playlist… from the drop-down menu. 

4. Give the playlist a title under Playlist Name.  

5. Browse through the selections on the left side and select additional tracks. Clicking on a track 
adds it to the playlist selection on the right. To remove a track from the playlist, select the track 
and click the red X. 

6. To rearrange or order the tracks in the playlist, drag and drop the tracks to the desired location, 
or you can also select a track and click the up or down arrow buttons to move it.  

7. Click OK when your playlist is completed. 

Your playlist will now be accessible through the Media Library under My Playlists. You can 
always edit the playlist at later time by right-clicking and choosing Edit… or you can drag and drop 
tracks from within the Media Library to the playlist.  

P.F.3. <CLIENT>  How do I add tracks to a playlist? 

 

1. Find and select the tracks you wish to add to your playlist. To select multiple tracks, hold the 
Ctrl key down while selecting the tracks. You can also select batches of tracks by clicking on 
the first track, holding down the Shift key, and then clicking the last track. 

2. Click the add to playlist button at the bottom of the screen or from the right-click menu. 

3. When prompted, select the playlist that you wish to add the tracks to and click save playlist.   

The new tracks will appear in the playlist.  

P.F.4. Is there a limit to the number of tracks in a playlist? 

There is currently a 200-track limit to the number of tracks you can have in a playlist. 
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P.F.5. <CLIENT>  How do I listen to a playlist? 

There are three ways to load a playlist: 

• Go to the MY COLLECTION tab and locate the playlist in the Playlists folders. Double-click 
on the playlist to load it into the player and begin playback. 

• Go to the MY COLLECTION tab and locate the playlist in the Playlists folders. Right-click on 
the playlist and select Play. 

• If you have the audio player detached (click NOW PLAYING), select the playlist from the my 
playlists drop-down menu in the upper right corner. 

P.F.6. <9 SERIES>  How do I listen to a playlist? 

There are two ways to load a playlist on the 9 Series player: 

• Select the playlist from the drop-down menu in the upper right corner of the 9 Series player 

• Go to the Media Library and locate the playlist in the My Playlist folders. Double-click on the 
playlist to load it into the player and begin playback. 

P.F.7. <CLIENT>  Is there a limit to the number of playlists I can create? 

There is no limit to the number of playlists you can create. 

P.F.8. What is The Mix? 

The Mix features an assortment of professionally programmed playlists from which you can build 
your own compilations.  

<CLIENT> You can choose suggested tracks from these mixes and then download and burn the 
tracks all at once, and even print customized CD inserts and labels. Or you can save the 
compilations as playlists and just stream the mixes directly.  

<9 SERIES> If you are using pressplay for Windows Media Player 9 Series, you can stream and 
download these customized mixes and print out your CD labels and inserts, but you need to use 
the 9 Series player to create playlists and burn the tracks. 

To access The Mix programmed playlists, click on The Mix link from the pressplay Magazine 
page. The mixes on this page are updated weekly. You can select from the featured mix titles, or 
browse by genre. 

P.F.9. <CLIENT> How do I burn a Mix playlist? 

 

1. Go to the pressplay Magazine sub-tab from the HOME tab, and then click The Mix. 

2. Browse through and select a mix title. Click on the View Tracks link for that mix. 
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3. From the list of tracks, click in the boxes for tracks you want to include on your CD. 

4. Click Next. 

5. Review the tracks you selected, and then click Download.  

Note: This is a good opportunity to create your custom CD insert and label by clicking on 
the Download graphics for your mix button. 

6. You will be notified when all your downloads have completed, at which point click the Burn 
Now! button to go straight to the BURN/TRANSFER tab with your tracks staged to burn.  

7. Verify that your burner is connected and that you have inserted a blank CD. 

8. Click the burn cd button. 

P.F.10. <9 SERIES> How do I listen to a Mix playlist? 

 

1. Go to the pressplay Magazine sub-tab from the HOME tab, and then click The Mix. 

2. Browse through and select a mix title. Click on the View Tracks link for that mix. 

3. From the list of tracks, click in the boxes for tracks you want to listen to. 

4. Click the Play button. 

If you want to download these tracks, then click the DOWNLOAD button. 

Note:  If you are using pressplay for Windows Media Player 9 Series, you can stream or 
download these customized mixes and print out your CD labels and inserts, but you need 
to use the 9 Series player to create playlists and burn the tracks.  For help with creating 
playlists and burning with Windows Media Player 9 Series, see the 9 Series player help. 

P.F.11. How do I create a custom CD insert and/or label for The Mix playlists? 

 

1. Once you make your selections from The Mix, you will see a button to Download graphics 
for your mix. 

2. A track list will be created based on the tracks you have selected for your mix. 

3. Click Ok when prompted to save the PDF file.  

4. Once it has finished downloading, open the PDF file.  

5. Load the proper blank insert or label into your printer. For more information on obtaining blank 
CD labels and inserts, go to http://www.neato.com/. 

6. Click the print button from Acrobat Reader. 

Note: To print these inserts and labels, you will need Adobe Acrobat Reader 5.1. You can 
get Acrobat Reader 5.1 for free from the following URL: 
http://www.adobe.com/products/acrobat/readstep2.html 
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P.F.12. How does the “Build Your Own Station” feature work and how are the tracks selected? 

The build me a station feature of Radio pressplay lets you build a customized radio station based 
on your listening preferences. A 200-track playlist is created on-the-fly based on recommendations 
from the tracks you have downloaded in your collection. Playlist are genre-based, so if you have 
downloaded tracks from different genres you can get a variety of different playlists. Each time you 
click BUILD NOW, a new station is created that could be based on a different genre (if your 
collection spans genres). And each time you click BUILD NOW a new selection of tracks will be 
selected, so each time you get a unique listening experience! If you do not have at least 10 
downloads in your collection, then the playlist will be based on your favorite genre. 

P.F.13. <CLIENT>  Can I create, listen to, or perform other actions on a playlist while I am offline? 

Playlist functionality is available offline, except you will not be able to add or listen to streamed 
tracks in the playlists while you are offline. 

P.F.14. Can I add tracks that I have downloaded to my playlist?  

<CLIENT>  Yes, your playlists may be comprised of streamed and/or downloaded tracks. 

<9 SERIES>  Your playlists may be comprised of pressplay downloads and any other tracks you 
have in your 9 Series player Media Library. 

P.F.15. Can I make a playlist with pressplay streams?  

<CLIENT>  Yes, your playlists may be comprised of streamed and/or downloaded tracks. 

<9 SERIES>  Your playlists may be comprised of pressplay downloads only. However, you can 
add streams to the tracks that are currently playing, by right-clicking and selecting Add to Current 
Playlist. You can also bookmark streams (right-click and choose Bookmark Track) and the track 
will be stored under BOOKMARKED TRACKS where they can be conveniently accessed. 

P.F.16. <CLIENT>  How do I "shuffle" or play the tracks in my playlist in random order? 

To play the current playlist in random order, first detach your player by clicking the NOW 
PLAYING button. This will detach the player and list the tracks in the current playlist. Click 
the shuffle button so it is ON if you want the tracks to play in random order. Toggle the 
button back to OFF if you want to play the tracks in the listed order. 

P.F.17. <CLIENT>  How do I add an entire album to a playlist? 

To add an album to an existing playlist, select BROWSE ARTIST/ALBUM from the FIND MUSIC 
tab and browse for the album. Select the album, right-click, and choose Add Album to Playlist. To 
start a new playlist based on the album, choose Add Album to New Playlist from the right-click 
menu. 
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P.F.18. What is Radio pressplay? 

Radio pressplay stations are professionally programmed, commercial-free stations customized to 
suit your tastes. Every time you listen to Radio pressplay, a new playlist of tracks is generated 
based on the station you choose. You can perform the same actions that you can perform on a 
playlist, such as skip, rewind, and view what’s in the queue. 

P.F.19. How do I listen to Radio pressplay? 

To listen to Radio pressplay:  

 

1. Sign in to pressplay. 

2. Go to the HOME tab.  

3. Click on the RADIO PRESSPLAY sub-tab.  

4. Select a station that suits your tastes.  

The station will start playing. To view which tracks are in the queue, you can click on the NOW 
PLAYING button on the pressplay application or the Now Playing menu button on the 9 Series 
player. 

P.F.20. How long are the Radio pressplay programs? 

Radio pressplay stations contain 200 tracks. If after 200 tracks you still want to hear more tracks on 
this station, play the station again and you will get a different selection and mix of tracks.  

P.F.21. Can I skip tracks on Radio pressplay or view what’s in the queue? 

You can perform the same actions on Radio pressplay that you can perform on a playlist, such as 
skip a track, rewind to hear the track again, and view what’s in the queue to play next. 

P.F.22. How are tracks delivered on Radio pressplay? 

Tracks on Radio pressplay are delivered as streams. 

<CLIENT>  If  you have downloaded the track it will automatically play the download. 

P.F.23. Do I have to be online to listen to Radio pressplay? 

You need to be online and signed in to listen to Radio pressplay. 

P.F.24. How often are new Radio pressplay stations added? 

New Radio pressplay stations are added or updated twice a week. 
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P.F.25. <9 SERIES> How can I see all the tracks currently queued up to play or that are coming up 
next on Radio pressplay? 

To view the tracks that are in queue to play next, go to Now Playing on your 9 Series player, and 
click on the + Now Playing on pressplay or + Radio pressplay link to the right to expand the list. 

9.2 Playlist and Radio K-base Only 

P.K.1. Can I add tracks obtained (or streamed) from other sources to my playlist?  

<CLIENT>  Currently, playlists created with pressplay can be composed of pressplay tracks only. 

<9 SERIES>  Any content that you have in your Windows Media Player 9 Series can be mixed 
with pressplay tracks in your playlists.. 

P.K.2. Can I share a playlist I created so other members can listen to it? 

Playlists cannot be shared with pressplay version 2.0 or higher. However, you can share your 
entire collection by editing your Public Profile and checking the box in front of “I'd like to make my 
collection and Member Name available …”. When other members use the Browse Members’ 
Collections or Search Members features, they will be able to view your collection. 

Note: Please allow 24 hours for updates to the Public Profile to take effect. 

P.K.3. Can I listen to a playlist from another computer other than the one I created it on?  

Currently, a playlist can only be played from the computer that you created it on. 

P.K.4. <9 SERIES>  Radio pressplay tracks won’t play directly from Now Playing. 

Please verify that you are signed in to the pressplay service. Radio pressplay tracks are streams, 
so you must be signed in to pressplay to play them. If you are listening to Radio pressplay when 
you close Windows Media Player 9 Series, and then return later (after 6 hours) and open the 9 
Series player again and start playing Radio pressplay straight from Now Playing, then the tracks 
may not play because the session has expired. 

To resolve this issue, simply sign in to pressplay, go to RADIO PRESSPLAY and click on the radio 
station of your choice to start it fresh.  
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10 Downloading Music  

10.1 Download FAQs 

D.F.1. How do I download a pressplay track? 

Downloads can be initiated from any search or browse screen where you see the download icon in 
the Options column for that track. Simply highlight your selection and click on the download 
button below the results window, or right-click on the highlighted track and select Download.  

<CLIENT>  If you are currently streaming the track you want to download, you can simply click the 
DOWNLOAD button on the player.  

For more information see the pressplay User Guide. 

D.F.2. Which tracks can I download? 

Any track that has the download icon in the Options column is available for download. To see if 
the download options have changed for tracks in MY COLLECTION or BOOKMARKED TRACKS 
since your last renewal: 

<CLIENT>  Select Refresh Track Options from the My Account drop-down menu. 

<9 SERIES>  Go to OPTIONS/HELP from the HOME page and click the Refresh Track Options 
link. 

D.F.3. When is a track available for download? How often does pressplay update the download 
selections? 

In general, tracks are made available for download when the CD is available for retail sale. We 
typically update our download selections on a daily basis. To see some of the tracks have been 
added today, see the “today: just added to pressplay” section on the pressplay HOME page. 

D.F.4. Why should I download a track when I can stream it? 

The following are benefits from downloading a track: 

• You can listen to track the when you are offline 

• The quality of a downloaded track is better (128 Kbps bitrate) than a stream (20/32/96 
Kbps) 

• Since the download is stored locally on your computer, it will not need to buffer or re-buffer 
before playing 

• <9 SERIES>  Downloaded tracks will be added to your Media Library; you can create 
playlists with downloads only. 
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D.F.5. What file format and bitrate are the downloaded tracks? 

For download files, pressplay uses the Window Media Audio (WMA) format encoded at 128 Kbps 
stereo. 

D.F.6. How does the quality of a downloaded track compare to a streaming track or CD? 

pressplay downloads are encoded at a higher bitrate than our streams and therefore are of better 
quality. pressplay downloads use a high-quality WMA format that comes near to CD quality.  

D.F.7. Can I rename a downloaded track? 

You should not attempt to manually rename a pressplay track as pressplay will not be able to 
locate the track and may list it as missing. 

D.F.8. Can I make a download permanent so it never expires? 

When you make a download a Portable Download, it is yours to keep even if your membership 
expires. In addition, you will be able to burn and transfer the Portable Download to a CD or portable 
music player. Any track that has the burn or transfer icon in the Options column can be made 
portable. 

D.F.9. How long do I get to keep my downloads? 

You can play your pressplay downloads as long as you are an active member. If you make a 
download a Portable Download, you can keep it even if you are no longer an active member. 

D.F.10. Where does pressplay store the downloaded tracks? Can I change this location? 

<CLIENT>  By default, pressplay stores your downloads in the C:\My Music\ directory. You can 
change the location where your downloads are stored by choosing Options from the File drop-
down menu at the top of the main pressplay window. See the pressplay User Guide for more 
details. 

<9 SERIES>  Your pressplay downloads are stored in the Windows Media Player 9 Series Media 
Library. The physical file is stored in the location specified under Tools > Options > Copy Music. 
Consult the 9 Series player help for more information on accessing and storing your downloads. 

D.F.11. Can I stream tracks or use other applications while I am downloading? 

pressplay runs behind the scenes, allowing you to perform most other tasks while you are 
downloading. The pressplay service is fully functional while you are downloading, so you can 
search for or stream other tracks. Depending on your computer’s capabilities, however, this may 
impact your streaming quality.  
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D.F.12. Can I copy my downloaded tracks to another computer? 

You can store and listen to your downloads on up to two computers (the original computer you 
downloaded the track on, and one additional computer). For example, if you downloaded the track 
at home, you can also have another copy of the download on your computer at work. To do this, 
you need to first install pressplay on the secondary computer, and use the Sync/Restore feature.  

Note: Portable Downloads are not included in the Sync/Restore. You can copy or re-
download a Portable Download on an additional computer, but it will be treated as a 
regular download that cannot be burned or transferred without using an additional Portable 
Download credit. 

D.F.13. If my hard drive fails or I get a new computer, how can I regain access to my downloads? 

You can use the pressplay Sync/Restore feature to restore your downloads to one additional 
computer at no extra charge. If you have already used up your Sync/Restore and your computer 
crashes, you bought another computer, or have other extenuating circumstances, then contact 
Customer Care and they can give you an additional Sync/Restore. 

D.F.14. I am a returning customer, how can I regain access to my prior account and downloads? 

If you reactivate a canceled membership within six months of your cancellation, you can regain 
access to your prior downloads. To do this, first sign up using your same member name and 
password. Once you are registered:  

<CLIENT>  Choose Sync/Restore from the My Account drop-down menu. 

<9 SERIES>  Go to OPTIONS/HELP from the HOME tab and click the Sync/Restore link. 

D.F.15. How do I play a track after I download it? 

<CLIENT>  Once your track has finished downloading, it will play automatically (as long as the 
auto-play option is selected). Once you download it, the track is stored in the MY COLLECTION 
tab, in the Downloads or Artists folder. To play it subsequent times, you can access it from that 
location. 

<9 SERIES>  Once the track has finished downloading, it is stored in the 9 Series player Media 
Library and can be played from there. The track will also remain in the DOWNLOAD STATUS 
page and can be accessed from there until you clear it from the download list. 

D.F.16. <9 SERIES> Where are my pressplay downloads saved and organized? 

Once you have downloaded a track on pressplay for Windows Media Player 9 Series, it is stored 
and organized in the 9 Series player Media Library along with your other media files. If you want 
to save a pressplay stream, you can right-click on the track and select Bookmark Track, and the 
track will be saved under BOOKMARKED TRACKS. 

To view only your pressplay downloads, expand the Subscriptions folder in Media Library, 
expand the Music sub-folder, and then click on pressplay. 
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D.F.17. Do I have to be online to play a downloaded track? 

Once you download the track, you do not need to be online to play the track. An Internet 
connection is required to download the track.  

Note: If you have not been online since the license for that track renewed, you may be 
prompted to sign in to acquire the license renewal. 

D.F.18. What if my download is listed as Missing? 

<CLIENT>  If the downloads is listed as Missing on the DOWNLOAD STATUS page, right-click 
and choose Restart Download from the drop-down menu. 

D.F.19. What if I accidentally delete a download file from my computer, how do I get it back? 

<CLIENT> When you launch pressplay, your default directory is scanned for the presence of your 
downloads. If a download is not in the default directory, it will have a Status of Missing on the 
DOWNLOAD STATUS sub-tab (under the MY COLLECTION tab). Click the restart download 
button to re-download the track. 

<9 Series>  If you delete a download from the 9 Series player Media Library, you can get the 
download back by going back to pressplay, searching for the track and downloading it again.  

D.F.20. Will pressplay let me download the same song twice? 

If you attempt to download a pressplay track that you already downloaded, the download 
option will not be available (unless the track is an alternate version).  

D.F.21. How do I download an entire album? 

If you browsed for the artist, you can select the album and click download to download the whole 
album at once (or right-click and choose Download Album). To download an entire album after 
you have searched for it, select each track on the album and then click the download button. You 
can click on the Album/Source column to sort by album, and also click on the first track, hold 
down the Shift key, and then click the last track to easily select the entire album. 

D.F.22. Why is my DOWNLOAD STATUS tab flashing? 

The DOWNLOAD STATUS tab flashes three times each time you initiate a download to let you 
know the download is in progress. 

D.F.23. <9 SERIES>  How do I clear out my DOWNLOAD STATUS tab without deleting the tracks? 

You can clear out your DOWNLOAD STATUS page once you have successfully downloaded 
tracks by clicking the clear completed button. This does not delete the downloads, but simply 
removes them from the status page. Once downloaded, the tracks can be accessed and organized 
on the Media Library page of the 9 Series player. 
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D.F.24. <9 SERIES>  I have existing pressplay downloads from using the standalone pressplay 
application; how can I add other pressplay content into Windows Media Player 9 Series? 

If you have other pressplay content that you want to add to the Media Library of the 9 Series 
player, you can add the folder where these downloads are stored to Media Library (typically C:\My 
Music\). To add a folder to Media Library, click + Add button, and then click Add Folder… from the 
drop-down menu. Navigate to and choose the folder where your pressplay downloads are stored, 
and then click OK. 

D.F.25. How can I listen to my downloads without being online? 

When you are prompted to sign in, click the LISTEN OFFLINE button.  

10.2 Download K-base Only 

D.K.1. How can I send a downloaded track to someone? 

<CLIENT>  At this time, you cannot send downloaded pressplay tracks. If the other person is a 
pressplay member, you can recommend the track to them. 

<9SERIES>  You can send a download to another pressplay member and the member can play it 
with the 9 Series player after it has been added to the Media Library. The track will be treated as a 
pressplay download on that computer and will require an active membership to be played and 
renewed.  

D.K.2. Can I choose an alternate file format and/or bitrate for my downloaded tracks? 

Currently, pressplay downloads are only available in Windows Media Audio format encoded at 128 
Kbps.  

D.K.3. Can I use another media player to listen to my downloaded tracks? 

We hope that you use pressplay (which uses Windows Media Player) or Windows Media Player 9 
Series to play your downloads. However, once you have downloaded your tracks, you are free to 
use other media players as long as they support WMA files. Currently, pressplay does not provide 
customer support for other players besides the Windows Media Player. For the best user 
experience, we recommend using pressplay or the 9 Series player to play your pressplay tracks.  

D.K.4. Does pressplay monitor how many times I listen to a download? 

For royalty purposes, pressplay measures the aggregate number of times a download is accessed 
through pressplay, whether online or offline. This measurement is used to ensure that artists are 
paid fairly. pressplay does not track aggregate usage of Portable Downloads. If you have any 
further questions, please refer to pressplay’s privacy policy. 
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D.K.5. <CLIENT>  How do I move my existing downloads to another drive or folder? 

By default, your pressplay downloads are stored in the location specified in the Options settings. If 
you want to move existing downloads, follow this procedure: 

 

1. Change the default directory by selecting File > Options. 

2. Under Download Directory, click the Browse button and browse to the new location that you 
would like to keep your downloads. Click OK. 

3. Manually copy and paste the downloads (with .WMA extension) from the old location to the 
new location (using Windows Explorer or another method). 

Note: If you delete the file and it is listed as Missing under DOWNLOAD STATUS, 
simply click restart download to download the track to the specified download directory. 

D.K.6. <9 SERIES>  How do I move my existing downloads to another drive or folder? 

Your pressplay downloads are stored in the Windows Media Player 9 Series Media Library. You 
can drag and drop tracks or folders within the Media Library to organize them to your liking. The 
physical files are stored in the directory specified under Tools > Options > Copy Music. Click the 
Change… button to change this location. See the 9 Series help for additional information. 

D.K.7. <CLIENT>  Do I have to store my downloads on my PC or can I store them on a Zip disk (or 
the equivalent)?  

Your downloads must remain in your specified Download Directory on your computer in order that 
pressplay can locate them for playback. You can make copies of the downloads and store them on 
a Zip or other disk, but these downloads must be copied back to the Download Directory before 
you can play them with pressplay.   

pressplay does not recommend setting your Download Directory to be on your Zip drive, as the 
access times for a zip drive would cause pauses in playback due to re-buffering. 

D.K.8. Track downloaded successfully but the content is defective (scrambled track, skips, etc.) 

 

1. Download the track and listen to it to verify that the track is defective. 

a. If you cannot duplicate the issue, then tell the customer:  

We could not duplicate the issue on our end. Please try deleting the track and 
downloading it again to see if you have the same problem. 

2. If the track is indeed defective, forward the message or report the issue to 
music@pressplay.com. 

3. Send back the following response to the customer (depending on which version they are 
using): 

Thank you for bringing this to our attention. It has been reported to our music team and will 
be resolved as soon as possible.  
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<CLIENT>  Please delete the track from your hard drive (locate and delete the WMA file in 
your default download directory, which is typically C:\\My Music\).  

<9 SERIES>  Please delete the track from the 9 Series player Media Library. 

As soon as we have fixed the track (typically 4-6 weeks) we will notify you. At this point 
you can re-download the track. 

4. Once the pressplay Music team has informed you that the track is fixed, provide the following 
response to the customer depending on which version they are using: 

<CLIENT>  The issue you reported has now been resolved. Please delete the track from 
your hard drive if you have not already done so. When you sign in to pressplay, the track 
should show up as “Missing” on the DOWNLOAD STATUS sub-tab (under the MY 
COLLECTION tab). Select the track and then click the restart download button. 

<9 SERIES>  The issue you reported has now been resolved. Please delete the track 
from your Media Library if you have not already done so. Then search or browse for the 
track in pressplay and download the track again. 

D.K.9. When I try to download, the status is stuck on “getting info” (Windows 98 and ME). 

If you have Windows 98 or ME, a likely cause might be that you have the Use a proxy server box 
checked and no proxy information entered. To correct this: 

 

1. Open Internet Explorer.  

2. Select Internet Options…from the Tools drop-down menu. 

3. Go to the Connections tab. 

4. Click the LAN Settings …button. 

5. Verify the proxy server settings: 

a. If the Use a proxy server box is checked and no information is entered, then unclick the 
box (assuming you are not using a proxy server).  

b. If you are using a proxy server, verify that the proxy server Address and Port is correct. If 
you are not using a proxy server, make sure this box is not selected. Consult your Network 
Administrator if you are unsure. 

6. Click the restart download button.  

D.K.10. My download fails part way through the download process and I can’t recover it. 

If the download process fails or is interrupted, click on the track and then click the restart 
download button.  

<CLIENT>  If the track is not listed on the DOWNLOAD STATUS page (under MY 
COLLECTION), or the restart download does not work, try manually deleting the track (with a 
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.wma extension) from the C:\My Music directory or your default download directory. Then exit and 
re-launch pressplay and the track should show up on the DOWNLOAD STATUS page as 
Missing. Click the restart download button. 

<CLIENT>  If the track is not listed on the DOWNLOAD STATUS page, or the restart download 
does not work, try manually deleting the track from the 9 Series player Media Library. Then try 
downloading the track again. 

D.K.11. When I try to play a track I previously downloaded, I get an error stating that the track is no 
longer available, or I get an error that states “Your membership must be updated to play 
this track”. 

<THIS MESSAGE IS DISPLAYED WHEN THE TRACK’S LICENSE HAS EXPIRED AND THE PHYSICAL 
WMA FILE DOES NOT CONTAIN THE CONENT ID IN ITS HEADER (AN ISSUE THAT HAS SINCE 
BEEN FIXED). THERE COULD BE 3 REASONS THAT THE LICENSES DO NOT GET RENEWED: 1) 
TRACK IS NO LONGER AVAILABLE…2) TRACK WAS NOT AVAILABLE WHEN RENEWAL WAS 
ATTEMPTED BUT IS AVAILABLE NOW …3) DB.BIN CORRUPTION. THE CCR SHOULD CHECK TO 
SEE IF THE TRACK IS STILL AVAILABLE IN THE SERVICE BY SEARCHING FOR THE TRACK IN 
PRESSPLAY. IF THE TRACK IS INDEED MISSING FROM THE PRESSPLAY CATALOG AND THE 
PROBLEM IS SPECIFIC TO THAT TRACK, THEN REPORT TO SECOND LINE (IF NOT ALREADY A 
KNOWN ISSUE) AND PROVIDE THE FOLLOWING ANSWER:> 

We are sorry for the inconvenience, but this track in no longer available.  

<CLIENT>  Please delete the existing download from your MY COLLECTION tab. 

<9 SERIES>  Please delete the existing download from your 9 Series player Media Library. 

There is a possibility that the unavailability of this track is temporary, so please try to download it 
again at a later date. 

<IF THE TRACKS ARE AVAILABLE FOR THE CCR BUT NOT THE CUSTOMER, THEN THE 
CCR ESCALATES THE ISSUE TO SECONDLINE@PRESSPLAY.COM. SO THAT THEY CAN 
INVESTIGATE WHETHER OR NOT THIS IS RELATED TO DB.BIN CORRUPTION. 

<NOTE: THE REPLY AND PROCEDURE BELOW SHOULD ONLY BE SENT AND 
PERFORMED BY PRESSPLAY SECOND LINE SUPPORT. >  

Thank you for contacting pressplay Customer Care. In order to better assist you, Customer Care 
has escalated your issue to our technical support group.  

We apologize for the inconvenience, but there is a known issue with your download license(s). This 
issue has since been resolved and will not happen again in the future.  

In order to repair your existing download license(s), please run the attached program by following 
these instructions. 

 

1. First close pressplay. 
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2. Save the attached ForceRenew.exe file to your C:\Program Files\pressplay\bin directory. 

3. Go to this same directory and double-click on the ForceRenew.exe file. 

4. Click the Start button when prompted.  

5. Click Done once the program has completed. 

6. Launch pressplay and sign in. 

The download(s) in question should now play properly, if not let us know. You can delete the 
ForceRenew.exe file once you have verified that the downloads work. Once again, we apologize 
for this inconvenience and thank you for your patience.  

D.K.12. My computer crashed but I already used up both my Sync/Restores. 

If you have already used up your Sync/Restore and your computer crashes, you bought another 
computer, or have other extenuating circumstances, then contact Customer Care and we can give 
you an additional Sync/Restore. 

D.K.13. When I try to do a Sync/Restore I repeatedly get an error that states: "We are unable to 
retrieve the information required to Sync/Restore your tracks." 

Before you can perform a Sync/Restore, the pressplay application needs to retrieve the necessary 
track information. It will try to obtain the track information within the designated timeout period, but if 
it does not retrieve the information, it will effectively give up and display a message. 

The default timeout period is twenty seconds, which is adequate for most connection speeds. If 
you have a slower dial-up connection and have acquired a lot of downloads, you may experience 
repeated timeout issues after 20 seconds when trying to perform a Sync/Restore. If this is the 
case, you may want to adjust the timeout period to allow for more time to gather the track 
information.  

To adjust the timeout period: 

 

1. <CLIENT>  Select Options from the File drop-down menu and go to the Advanced tab. 

<9 SERIES>  Select OPTIONS/HELP from the HOME tab and click the Advanced link. 

2. Under Timeout for network communications, increase this number using the up arrow 
button. It is best to increase this only as much as necessary to avoid the unnecessarily long 
wait time. 

3. Attempt to perform the Sync/Restore again. 

D.K.14. Why did I receive a "no more uses" error, when I have unlimited downloads? 

pressplay allows unlimited downloads as long as those tracks remain on the computer you 
downloaded them to. Each download can be sync/restored or downloaded again to one additional 
computer. 
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D.K.15. <GATEWAY ONLY> My hard drive crashed, or I lost my pre-loaded pressplay content. 

If you have the Gateway Music Vault by pressplay Mega Pack membership with 2000 pre-loaded 
tracks and experience hard drive failure or another issue that caused you to lose your pressplay 
downloads, contact your Gateway support to see if you can have your hard drive restored. 

If you have the Genre Pack membership with 150 pre-loaded tracks and have an issue that causes 
you to lose these downloads, then contact your Gateway support to obtain a CD or DVD with these 
tracks.  

You can contact Gateway Support at 800.846.2301 or by visiting the following site:  

http://support.gateway.com/support/default.asp 

D.K.16. <GATEWAY AND MEGA PACK ONLY> Why are my downloads stored in two locations on 
my C: and D: drives? 

If you have a Mega Pack membership, then your pre-loaded downloads are physically stored on 
your D: drive. When you first register for the Mega Pack membership, you will be prompted for a 
location to store your future pressplay downloads. If you accept the default (C:\My Music\) then any 
new downloads will be stored in this location on your C: drive. This will not affect playback and how 
the downloads are stored within the MY COLLECTION tab of pressplay. 

If you want all your physical download files to be stored in one place, you should set your default 
download directory to be D:\My Music\. If you did not set this during registration, you can change it 
at any time by selecting File > Options and changing the Download Directory accordingly. 

D.K.17. <GATEWAY ONLY> Why does MusicMatch launch when I try to play my pressplay tracks? 
Do I need to install the WMA plug-in for MusicMatch? 

The default player that comes with your Gateway Music PC is MusicMatch, so if you try to directly 
play a WMA file for the first time, you will be asked to download a WMA plug-in for MusicMatch. In 
order to play your pressplay downloads, you need to first register for pressplay (select Start > 
Programs > pressplay). Once you register, you can play those downloads directly through the 
pressplay application. 

D.K.18. <GATEWAY ONLY> Why is there a lag time when I first try to play my pre-loaded 
downloads? 

When you launch pressplay for the first time, the pressplay application needs to gather the 
necessary information about your pre-loaded downloads. This is a background process, and you 
will be able to perform other pressplay functions while this is happening, but may experience a 
short lag time when attempting to play your downloads or access other features. You will not 
experience these performance issues after this initial download information gathering process 
completes (if you are on a dial-up connection this may take roughly 90-100 minutes, and if you are 
a broadband user this should complete in approximately 35-40 minutes).  
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D.K.19. How do I repair defective downloads? (Includes downloads causing latency issues prior to 
2.5) 

If you have any defective downloads that have since been fixed in the pressplay system, these will 
automatically be detected when you first sign in. The only action you need to take is to verify that 
the tracks are selected and click the repair selected button. When you click the repair selected 
button, the downloads will automatically be re-downloaded with the corrected version. If you 
choose not to repair the tracks, then click the cancel button, but keep in mind that you may 
continue to experience issues with these tracks.  

Note: If you want to repair the tracks at a later time, you can click cancel and the next time you 
sign in you can choose repair selected. 

11 Portable Downloads 

11.1 Portable Downloads FAQs 

L.F.1. Can I purchase my downloads outright so I can keep them even if I am not a pressplay 
member? 

You can convert your downloads to Portable Downloads to make them permanent. Portable 
Downloads may be burned to CD, transferred to a portable device, and kept after your 
membership expires. If you want to purchase more Portable Downloads than what are allotted in 
your membership plan, you can purchase packages of Portable Downloads for less than $1 per 
download.   

L.F.2. How do I get a Portable Download? 

To download a track as a Portable Download: 

 

1. Find the track by browsing or searching. 

2. Right-click and choose Make Portable. 

3. Click YES to accept the offer. 

You can keep Portable Downloads even if your membership expires and burn them to CD and 
transfer them to a portable device (if the options are available). 

L.F.3. What is a Portable Download pack? 

pressplay Portable Download packs are a convenient way to purchase additional Portable 
Downloads. The following Portable Download packs are available: 

• 5-pack of Portable Downloads for $5.95 

• 10-pack of Portable Downloads for $9.95 
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• 20-pack of Portable Downloads for $18.95 

Portable Download credits from your Portable Download pack will not expire as long as you are a 
pressplay member. 

Portable Download packs can be purchased directly from the Account Status page. If you attempt 
to burn or transfer a track without enough existing credits, you will also be given the opportunity to 
purchase a Portable Download pack at that time.  

L.F.4. How many times can I burn or copy the same Portable Download? 

You can burn or copy each Portable Download one time. You can also transfer the Portable 
Download to a portable device. If you want an additional burn, you can use another Portable 
Download credit. 

L.F.5. Can I burn and transfer an entire album? 

Yes, you can burn and transfer as many tracks from an artist or album as you like. There is no 
restriction on the number of tracks per artist that you can burn and transfer, as long as you have 
the available Portable Download credits. 

L.F.6. What happens when I reach my limit of Portable Downloads? 

When you use up your allotted Portable Download credits, you will be prompted to purchase a 
Portable Download pack. 

L.F.7. If I do not use up my Portable Download credits, do they carry over into the next billing 
period? 

The Portable Download credits allotted for your membership period do not carry over unless they 
are Portable Download credits purchased via a 5-, 10-, or 20-pack of Portable Downloads. At the 
beginning of each billing period, your Portable Download credits from your membership reset to the 
amount allotted in your membership plan regardless of whether you have unused credits left over 
from the prior month.  

L.F.8. Can I transfer my Portable Downloads to another computer? 

The sync/restore feature may be used to copy your downloads to one additional computer. 
However, you cannot sync/restore Portable Downloads to another computer.  

<CLIENT>  Portable Downloads can be played only on the computer that you made it portable on. 
To play the download on another computer, you can download the track to a second computer but 
it cannot be burned or transferred from that secondary computer. 

<9 SERIES>  You can copy or send your Portable Downloads to another computer that has 
Windows Media Player 9 Series, but the Portable Download will be treated as a regular download 
without burn and transfer rights, and download rights that will expire if there is not active pressplay 
membership. The track should be added to the Media Library before you play it. 
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Any burns or transfers must be initiated from the computer that you downloaded the Portable 
Download to. 

L.F.9. Do I have to be online to burn a CD or transfer Portable Downloads to a PD?   

In order to burn CDs or transfer your pressplay Portable Downloads to a PD you must have an 
active Internet connection and be signed in to pressplay. 

L.F.10. If I cancel a CD burn, Net MD Copy, or PD Transfer in the middle of the process, does it 
count? 

Your Portable Download count is decremented after you click the burn or copy button and accept 
the offer. If at any point after the Roxio plug-in screen displays you cancel the process, you will still 
be counted for the Portable Downloads. If you canceled a CD burn in error, contact Customer Care 
at 888.660.2265 or use the Customer Care forms available from the Help menu. 

L.F.11. If I accidentally make a track a Portable Download that is already a Portable Download will 
my Portable Download count get decremented again? 

If you make a track a Portable Download, then the next time you right-click on it, the Make 
Portable option will be grayed out. If you select a batch of tracks and some of the tracks are 
already Portable Downloads, then pressplay will detect this and only decrement you for the tracks 
that are not yet Portable Downloads.  

However, if you burn your Portable Download and then want to burn it again, you will have to use 
another Portable Download credit. 

L.F.12. If I make a track a Portable Download, is there a time limit as to when I have to burn or 
transfer it? Can I burn or transfer a track even if I am no longer a member? 

Once you make a track a Portable Download, the burn and transfer licenses do not expire and can 
be used at a later time, even if you are no longer a member. Keep in mind that you are allowed to 
burn a Portable Download one time.  

L.F.13. How many times can I transfer a Portable Download? 

For each Portable Download, you are allowed unlimited transfers to 3 different registered and 
supported devices. 

L.F.14. Can I listen to tracks that only have burn or transfer options without using a Portable 
Download credit?  

If a track does not have the stream or download icon, you can preview the track before you make it 
portable. You can hear a 30-second clip simply by double-clicking on the track, or selecting the 
track and clicking the play button. If you want to hear the entire song, you can right-click and 
choose Make Portable. This will require a Portable Download credit, which will also enable you to 
burn and transfer the track.  
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11.2 Portable Downloads KB Only 

L.K.1. Are Portable Downloads included in the pressplay 3-day trial? 

The pressplay 3-day trial allows unlimited streaming and downloading over a 3-day period, but 
does not include Portable Downloads. If you wish to burn your pressplay tracks to CD and transfer 
them to PD, then you should start your paid pressplay membership plan. To start your pressplay 
membership: 

<CLIENT>  Select Account Status from the My Account drop-down menu, and then select 
START MEMBERSHIP PLAN NOW!  

<9 SERIES> Select Account Status from the OPTIONS/ HELP page on the HOME tab, and then 
select START MEMBERSHIP PLAN NOW! 

You can also purchase a 5-, 10-, or 20-pack of Portable Downloads when you are still in the trial, 
but keep in mind that the Portable Download credits will expire at the end of your trial unless you 
sign up for a paid membership plan. 

L.K.2. A track that I want to burn or transfer does not have the burn (or transfer) icon under 
options. 

The option to burn or transfer a track is granted to pressplay by the music labels we partner with. 
There is a chance that these options may have changed since your membership last renewed.  

<CLIENT>  To update the options for tracks in MY COLLECTION to match what is currently 
available, click Refresh Track Options from the My Account drop-down menu.  

<9 SERIES>  To update the options for streams in BOOKMARKED TRACKS to match what is 
currently available, go to the OPTIONS/HELP page on the HOME tab, and click Refresh Track 
Options. 

If the burn (or transfer) icon still does not display, then the track is currently not available to burn (or 
transfer). Every membership period these options refresh automatically, but you can check back at 
any time using the Refresh Track Options feature. 

L.K.3. Why can't I completely stream or download some songs before I make them Portable 
Download? 

The options to stream, download, or burn/transfer a track are granted to pressplay by the music 
labels we partner with. In some infrequent cases the only current available options may be to burn 
and/or transfer the track (and use a Portable Download credit). However, we do offer a 30-second 
preview of the track that can be accessed by double-clicking on the track and does not require 
using a Portable Download credit. 

When you burn or transfer the track, or make the track a Portable Download, you will also be able 
to listen to and keep the download. If you do not want to make the track a Portable Download, 
please check back at a later time as the options do change. 
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L.K.4. Portable Download credits discrepancies.  

It you have pending Portable Downloads that failed during download, it is possible that your 
Portable Download credit count might not update correctly. Check your DOWNLOAD STATUS tab 
and if there are any downloads that have a status of Failed or Unauthorized, then try highlighting 
these and clicking restart download. If the downloads still fail, then highlight them and click the 
delete button. Once the failed downloads have been deleted from the DOWNLOAD STATUS tab, 
your Portable Download credit count should update correctly. If you still want to make these failed 
tracks Portable Downloads, you can try using the refresh track options feature to update the 
available options, and then try making them portable again. 

L.K.5. A download that I made into a Portable Download is defective (Includes downloads causing 
latency issues prior to 2.5) 

If you have any defective downloads that have since been fixed in the pressplay system, these will 
automatically be detected when you first sign in. The only action you need to take is to verify that 
the tracks are selected and click the repair selected button. When you click the repair selected 
button, the downloads will automatically be re-downloaded with the corrected version.  

<<<NOTE: THE NEXT PARAGRAPH WOULD ONLY BE USED FOR INQUIRIES ABOUT THIS 
ISSUE. IF THE CUSTOMER SPECIFIES THE DEFECTIVE DOWNLOAD(S) THEY MADE 
PORTABLE, THEN THE PDL METER COUNT WOULD BE ADJUSTED AND THE CUSTOMER 
WOULD BE INFORMED OF THIS INSTEAD OF USING THE FOLLOWING PARAGRAPH. >>> 

If you used a Portable Download credit to burn or transfer this defective download, then contact 
Customer Care so we can adjust your Portable Download credits accordingly.  

L.K.6. Why does a track have a “30” icon, but no stream or download icon? 

If a track has a “30” icon in the Options column, you cannot stream or download the track in its 
entirety, but can preview the track for 30 seconds. This option is provided as a courtesy so you can 
sample the track before making it a Portable Download, at which point you can hear the complete 
track, and burn and transfer the track. 

12 CD Burns and PD Transfers 

Note: pressplay for Windows Media Player 9 Series uses native 9 Series Copy to CD or 
Device functionality. pressplay on 9 Series users should refer to the 9 Series player help 
for additional information on copy and transfer functionality.  

12.1 CD Burn and PD Transfer FAQs 

B.F.1 <CLIENT>  How do I burn Portable Downloads to a CD using the pressplay application? 

Note: before you attempt to burn, verify that you have a compatible CD burner installed 
and that it is detected by your operating system. 



pressplay K-base  CD Burns and PD Transfers 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 80 
 

Note: Before you burn a track you must first download the track or directly make the track 
a Portable Download. If the track has not been downloaded, it will not appear under tracks 
available to burn. 

 

1. Go to the BURN/TRANSFER tab. 

2. Select the BURN TO CD sub-tab. 

3. Select Available Tracks or locate the tracks under Available Artists or Playlists. If the 
track(s) you want to burn are not listed, then verify that they have been downloaded and have 
burn options.   

4. Drag and drop the tracks you want to burn from the upper area into the lower burn staging 
area. 

5. Drag and drop tracks to the desired location within the list or use the provided arrow keys to 
move the tracks up and down in the order.   

6. Once you have added and sorted all the tracks in the burn staging area, click burn cd. Please 
be patient while the necessary track information is gathered. 

7. Click YES to accept the offer. 

8. Insert a writable CD into your CD-ROM drive if you have not already done so. 

9. Click Burn. 

Note: Please do not cancel the burn process once you have started it or you may 
inadvertently use up your burn license. 

A status screen displays the progress of the CD burning process. See the pressplay User Guide 
for more details. 

Once the burn completes, the Roxio Basic CD Label Creator will launch so you can create a label 
for your CD. 

B.F.2 <9 SERIES>  How do I burn Portable Downloads to a CD using the 9 Series player?  

Note: before you attempt to burn, verify that you have a compatible CD burner installed 
and that it is detected by your operating system 

 

1. First download the tracks or make the tracks into Portable Downloads from pressplay. Verify 
that the tracks have burn options. 

2. Click the Copy to CD or Device menu option on Windows Media Player 9 Series. 

3. Locate the tracks on the left under Items to Copy. Use the drop-down menu to look for tracks 
by artist, playlist, or favorites.  

Tip: If you are making a compilation CD, it helps to first create a playlist with the tracks you 
want and then just select the playlist from the drop-down menu under Items to Copy. 

4. All the tracks with a status of “Ready to copy” are staged to burn. Click the small checkbox on 
the left to de-select the track or click to select. 
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5. Drag and drop the tracks in the list to arrange them in the desired order. 

6. Under Items on Device on the right side, verify that Roxio CD Burning is selected from the 
drop-down menu. 

7. Insert a writable CD into your CD-ROM drive if you have not already done so. 

8. Once you have selected and sorted all the tracks and have the proper device selected, click 
the Copy button. Please be patient while the necessary track information is gathered.  

9. Click YES to accept the offer. 

Note: Please do not cancel the burn process once you have started it or you may 
inadvertently use up your burn license. 

A status screen displays the progress of the CD burning process. Refer to the 9 Series player help 
for additional information on copy and transfer functionality. 

B.F.3 Do I need a CD burner and software to burn CDs?  

In order to burn Portable Downloads to CD, you must have a CD burner, recordable CDs, and 
Windows Media Player. Windows Media Player comes with Roxio CD burning capability that is 
compatible with most CD burners.  

B.F.4 Which CD Burners are supported by the Roxio CD burning software? 

The Roxio CD burning software supports most standard CD burners. To check if your particular 
CD burner is supported, go to: 

http://rpp.roxio.com/drives/?page=supported_drives  

If you have a new CD RW that is not on the list, check back in the near future as Roxio updates 
this list frequently. 

B.F.5 How can I get an upgrade to my Roxio burn software? 

To check for available updates to your Roxio Easy CD Creator software, go to the following URL: 

http://www.roxio.com/en/support/software_updates.jhtml  

To update your CD burner engine software, go to: 

http://www.pressplay.com/support/engine/  

B.F.6 Which tracks am I allowed to burn to CD? 

Any track that has the burn icon displayed in the Options column can be burned to CD, provided 
you have sufficient Portable Downloads left in your membership plan. Also note that before you 
burn a track, it must first be downloaded or directly made in to a Portable Download. 



pressplay K-base  CD Burns and PD Transfers 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 82 
 

B.F.7 What format are the pressplay burns? 

When you burn a CD using pressplay, the tracks will be in the standard CD audio format (CDA). 

B.F.8 Can I play a CD I burned on pressplay in my car stereo or other audio system? 

The CDs you burn with pressplay are playable on most standard audio systems and car stereos as 
long as they support the CD format (CD-R or CD-RW) that you used to burn the CD. If your CD 
does not play on an audio system, please verify that you are using CD-R format and not CD-RW (if 
your audio system does not support CD-RW). 

B.F.9 Can I burn a track without first downloading it? 

The track must first be downloaded to your hard drive or made a Portable Download, before you 
can burn it to CD. 

B.F.10 Can I use my player or another application to burn pressplay tracks? 

Other software such as Easy CD Creator or Windows Media Player may be used to burn Portable 
Downloads, but pressplay can only provide support for burns initiated through the pressplay 
application or Windows Media Player 9 Series. 

B.F.11 Can I stream, download, or run other applications while I am burning a CD? 

It is best not to download, stream, or run any other applications while you are burning as this 
increases the possibility that the burn process could fail. 

B.F.12 I tried to burn and nothing happened. 

Please be patient after you click the burn cd or Copy button to allow the process to initiate. Do not 
attempt to cancel the burn process once you click the burn cd or Copy button as your Portable 
Download credits may be decremented even if the burn process was canceled. 

B.F.13 Where can I get help if I am having problems with the Roxio CD burning software? 

The Roxio Web site contains some additional FAQs pertaining to the Roxio Basic CD Burning Plug-In 
for pressplay: 

http://www.roxio.com/en/support/plugins/pressplay_techqs.html 

In addition, more general support for Roxio software products can be found at: 

http://www.roxio.com/en/support/index.jhtml  
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B.F.14 Can I burn a few tracks to a CD using pressplay, and then add more to the same CD at a 
later time?  

Once you burn a CD with pressplay, the session is finalized and you cannot add more tracks to 
that same CD. We suggest that you first gather all the tracks you want in a compilation, and then 
burn them all in one session. 

B.F.15 <CLIENT>  How do I get the Roxio Basic CD Label Creator? 

Click Update pressplay from the My Account drop-down menu. There is a link here to install the 
Roxio Basic CD Label Creator.  

B.F.16 <CLIENT>  How can I create a label for my CD? 

If you have installed Basic CD Label Creator, you will automatically be prompted to create a CD 
label when the CD burn process completes. The track information for the tracks you burned will 
automatically populate the fields in the chosen order, so all you have to do is give it a title and print 
it!  

Note: If you are burning a playlist from The Mix, there are customized CD inserts and 
labels available in PDF format from that page. 

B.F.17 <CLIENT>  Can I create a label before I make the CD or at another time? 

You can make a CD label at any time by clicking the Basic CD Label Creator icon that is located 
on your desktop. As with any other software, we encourage you to avoid creating labels while the 
CD burn is in process. 

B.F.18 <CLIENT>  How do I get help for making my CD label using the Basic CD Label Creator? 

Help options are available for the Roxio Basic CD Label Creator by selecting the Help drop-down 
menu. 

B.F.19 <9 SERIES> Why are tracks listed with a status of “Cannot Copy” on the Copy to CD or 
Device page? 

The beta version of pressplay for Windows Media Player 9 Series player may incorrectly display 
some streams on the Copy to CD or Device page as “Cannot Copy”. Many of these streams may 
indeed be available for copying or transferring, but must first be downloaded. To copy these 
streams with burn or transfer rights, return to pressplay and find these tracks and then download 
them. Once they are downloaded, they will be available to copy. 

B.F.20 Do I need a portable device (PD) and software to transfer tracks? 

In order to transfer Portable Downloads to a portable device, you must have a supported PD, 
recordable media, and Windows Media Player.  
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B.F.21 Which portable music players are supported by pressplay? 

Most flash and hard disk based portable music players that support the Windows Media format are 
compatible with the pressplay service. To see if your portable music player is compatible, go to: 

http://www.pressplay.com/compatible_devices.html   

B.F.22 <CLIENT>  How do I transfer Portable Downloads to a portable device using the pressplay 
application? 

Note: Before you attempt to copy or transfer, verify that you have a compatible portable 
device installed and that it is detected by your operating system. 

Note: Before you transfer a track you must first download the track or directly make the 
track a Portable Download. If the track has not been downloaded, it will not appear under 
tracks available to transfer. 

 

1. Go to the BURN/TRANSFER tab. 

2. Select the TRANSFER TO PORTABLE DEVICE sub-tab. 

3. Select Available Tracks or locate the tracks under Available Artists or Playlists. If the 
track(s) you want to transfer are not listed, then verify that they have been downloaded and 
have transfer options. 

4. Drag and drop the tracks you want to burn from the upper area into the lower track staging 
area. 

5. Drag and drop tracks to the desired location within the list or use the provided arrow keys to 
move the tracks up and down in the order.   

6. Once you have added and sorted all the tracks in the burn staging area, click transfer to PD. 

7. Click YES to accept the offer. 

8. Windows Media Player launches with your selected tracks ready to transfer. Verify that your 
portable device is connected and contains the proper media. 

9. Click Copy Music from Windows Media Player. 

A status screen displays the progress of the transfer process. See the pressplay User Guide for 
more details.  

B.F.23 <9 SERIES>  How do I transfer Portable Downloads to a portable device using the 9 Series 
player?  

Note: Before you attempt to copy or transfer, verify that you have a compatible portable 
device installed and that it is detected by your operating system. 

 

1. First download the tracks or make the tracks into Portable Downloads from pressplay. Verify 
that the tracks have transfer options. 
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2. Click the Copy to CD or Device menu option on Windows Media Player 9 Series. 

3. Locate the tracks on the left under Items to Copy. Use the drop-down menu to look for tracks 
by artist, playlist, or favorites.  

Tip: If you are making a compilation, it helps to first create a playlist with the tracks you 
want and then just select the playlist from the drop-down menu under Items to Copy. 

4. All the tracks with a status of “Ready to copy” are staged to transfer to PD. Click the small 
checkbox on the left to de-select the track or click to select. 

5. Drag and drop the tracks in the list to arrange them in the desired order. 

6. Under Items on Device on the right side, select the portable device that you want to transfer 
to. 

7. Once you have selected and sorted all the tracks and have the proper portable device 
selected, click the Copy button. Please be patient while the necessary track information is 
gathered.  

8. Click YES to accept the offer. 

A status screen displays the progress of the transfer process. Refer to the 9 Series player help for 
additional information on copy and transfer functionality. 

B.F.24 When I attempt to transfer to a PD, Windows Media Player launches with no device listed or 
recognized.  

Before attempting to transfer your Portable Downloads to a portable device, verify that your 
portable device player is connected and detected by your operating system. If you open up 
Windows Media Player and go to the Copy to CD or Device tab, your device should be listed 
under Music on Device. You may need to press the F5 key to refresh Windows Media Player.  

If it your device is not detected, verify that the device is turned on and has batteries. If it is still not 
recognized, disconnect the USB cable from the portable device for about 5 seconds and then 
connect it securely to the device. If the condition does not change, restart your computer with the 
device connected. 

B.F.25 <CLIENT>  Can I have Windows Media Player open when I transfer tracks?  

Please close Windows Media Player before starting to transfer to a portable device. When you 
click the transfer to PD button, pressplay will automatically launch Windows Media Player with the 
tracks you want to transfer staged to transfer to PD. 

B.F.26 <CLIENT>  When I attempt to transfer to PD, pressplay cannot successfully launch 
Windows Media Player.  

In order to transfer Portable Downloads to a portable device, pressplay will launch Windows Media 
Player. If pressplay is not able to launch Windows Media Player, please verify that your Windows 
Media Player is working properly, or that you have not moved it to a location where the pressplay 
application cannot locate it. If you are still having issues, we recommend that you uninstall 
Windows Media Player and reinstall it. 
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Note: Net MD players launch the Roxio plug-in that comes with pressplay, not Windows 
Media Player. 

To uninstall Windows Media Player, select Start > Settings > Control Panel > Add/Remove 
Software. Locate Windows Media Player and click Change/Remove.  

To download and install the latest Windows Media Player, go to: 

http://windowsmedia.microsoft.com/download/download.asp      

B.F.27 My Compaq iPAQTM PA-1 or PA-2 portable music player gets an error when trying to 
transfer content from pressplay when using Windows Media Player   

You may need an updated device driver that supports the transfer of secure content. You can 
download a driver from http://www.rioport.com/CompliantDevices/1,4933,,00.html.  

B.F.28 Who can I contact if I am having issues with my portable music player? 

If you have questions or concerns related to your portable music player, please contact customer 
support for the manufacturer of your device. pressplay Customer Care can only support issues 
related to the pressplay service. 

For issues or additional questions related to Rio or Nike psa[play products, please contact SONIC 
| blue support by visiting their customer support site:  

www.sonicblue.com/support  

For issues related to your Creative NOMAD player, see:  

http://www.americas.creative.com/support/welcome.asp?RD=faq  

For additional FAQs related to your Compaq iPAQTM player, see: 

  http://wwss1pro.compaq.com/support/home/index.asp  

B.F.29 Do I need a Net MD device to copy Portable Downloads to a MiniDisc?  

<CLIENT>  In order to copy Portable Downloads to a MiniDisc, you need a Net MD device and 
recordable MDs as well as OpenMG Jukebox 2.2 or SonicStage on Vaio.  

<9 SERIES>  pressplay for Windows Media Player 9 Series is not currently compatible with Sony 
Net MD. If you want to transfer your Portable Downloads to a Net MD device, you can use the 
standalone pressplay application. 

B.F.30 <CLIENT>  Which tracks can I copy to a Net MD device? 

Any track that has the burn icon displayed in the Options column can be copied to a Net MD 
player, provided you have sufficient Portable Download credits left in your membership plan. Also 
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note that before you copy a track, it must first be downloaded or directly made in to a Portable 
Download.  

B.F.31 <CLIENT>  How do I copy Portable Downloads to a Net MD portable player? 

Note: Before you attempt to copy tracks to a Net MD portable player, verify that you have 
the device correctly installed and that it is detected by your operating system. 

Note: Before you copy a track you must first download the track or directly make the track 
a Portable Download. If the track has not been downloaded, it will not appear under tracks 
available to copy. 

 

1. Go to the BURN/TRANSFER tab. 

2. Select the COPY TO NET MD sub-tab. 

3. Select Available Tracks or locate the tracks under Available Artists or Playlists. If the 
track(s) you want to copy are not listed, then verify that they have been downloaded and have 
burn options. 

4. Drag and drop the tracks you want to burn from the upper area into the lower track staging 
area. 

5. Drag and drop tracks to the desired location within the list or use the provided arrow keys to 
move the tracks up and down in the order.   

6. Once you have added and sorted all the tracks in the burn staging area, click copy to Net MD. 

7. Click YES to accept the offer. 

8. Verify that your Net MD device is properly connected and insert a writable MiniDisc if you have 
not already done so. 

9. Click Copy. 

Note: Please do not cancel the copy process once you have started it or you may be 
inadvertently decremented for the Portable Downloads. 

A status screen displays the progress of the copy process. See the pressplay User Guide for more 
details.  

B.F.32  <CLIENT>  My compatible Sony Net MDTM device is not recognized by my computer or 
cannot be operated by my OpenMGTM Jukebox.  

If your Net MDTM player is not recognized by your computer or cannot be operated by your 
OpenMGTM Jukebox, then disconnect the USB cable from the Net MD for about 5 seconds and 
then connect it to the Net MD player again. If the condition does not change, restart your computer. 

B.F.33 <CLIENT>  Do I have to delete the existing music on my MiniDisc before copying new 
tracks to a Net MD player?   

MiniDiscs are read/write, meaning you can add new tracks to an existing MiniDisc as long as there 
is room left on it. The Roxio plug-in will let you know if there is a sufficient space left on the MiniDisc 
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to copy the tracks. If you do not have enough space, pressplay will prompt you to revise your list of 
tracks and try again. If you wish to delete tracks from your MiniDisc, please use Open MagicGate 
Jukebox.  

B.F.34 <CLIENT>  After I have copied pressplay tracks to a MiniDisc can I change the order of the 
songs?  

Yes, you can change the order using Open MagicGate Jukebox.  

B.F.35 <CLIENT>  Who can I contact if I am having issues with my Net MD player?  

If you have questions or concerns related to your Net MD player, please contact customer support 
for the manufacturer of your device. pressplay Customer Care can only support issues related to 
the pressplay service. 

For issues related to Sony Net MD devices, please visit their support Web site at: 

http://www.musiclub.sonystyle.com/supportcenter.jsp?categoryId=9 

There are also additional Sony Net MD FAQs posted at: 

http://ciscweb.sel.sony.com/scripts/web_access.cgi?FUNC=DIAGNOSE&DIAGNOSTIC_
TYPE=2&PARENT_ID=8489  

For additional FAQs and support information related to your Sharp Net MD player, please 
visit their support Web site at: 

http://www.sharpelectronics.com/products/FunctionFaqs/0,1072,17,00.html  

12.2 CD Burn and PD Transfer KB Only 

B.K.1 What if a failure occurs during the burn or transfer process or the burned or transferred 
track is defective?  

If for some reason your track does not burn successfully, then tell us the Artist/Album/Track and 
any other information about your operating system and software that may help us to resolve the 
problem. Also indicate if the same download track played correctly through pressplay. This may 
indicate that there was a problem with the CD burner, the burning software, or the PD. 

B.K.2 Can I copy and distribute CDs that I made with pressplay?  

You may burn a track (to either a CD or Net MD) for personal use only once for each Portable 
Download credit. If you would like to burn the same track an additional time, you must use an 
additional Portable Download credit. Once you have burned a track to a CD or copied to a Net MD, 
you agree not to copy, distribute, or transfer the track from that CD or Net MD to any other audio or 
audio-visual disk, cassette or playback device. 
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B.K.3 I get a “No CD burning devices detected on the system” error even though my burner was 
on Roxio’s list of supported devices. 

First check to see if the burner has been installed and is detected by your computer:  

 

1. Right-click on the My Computer icon on your desktop and choose Properties from the drop-
down menu. 

2. Go to the Hardware tab. 

3. Click the Device Manager button. 

4. Under DVD/CD-ROM Drives, check to see if your burner is listed. 

5. If your CD-RW drive is listed, then double-click on it. Under Device Status it should read: “This 
device is working properly.” 

If your device is not listed or does not have a good status, then consult your CD-RW 
documentation to correctly install your burner, and then try burning with pressplay. 

If your CD-RW is listed and working properly and you are able to burn with other software 
applications besides pressplay, try upgrading the Roxio burn engine at the following URL: 

http://www.roxio.com/pressplay/engine/  

If you are still having issues after going through the burn engine upgrade, then verify that your 
burner is compatible with Windows Media Player: 

 

1. Open Windows Media Player. 

2. Select Check for Player Upgrades … from the Help drop-down menu. 

3. If the Adaptec CD-burning plug-in appears in the Components list, select it and continue 
with the upgrade. 

Note: The Adaptec CD-burning plug-in is not required to burn with pressplay, but it will 
verify that the burner is compatible with Windows Media Player, in which case it should 
also be compatible with pressplay.  

After the Windows Media Player upgrade, see if you are able to burn. If you are still not able to 
burn, please contact us again. 

B.K.4 <CLIENT>  I get a “file format not supported” error when I try to burn. 

First verify that you are using the pressplay application to perform the burn. Other burning software 
cannot properly obtain the license requests. 

Only pressplay tracks can be burned using pressplay. Verify that the track names (in the C:\My 
Music\ directory or your default download directory) are valid and have not been altered (they 
should have .wma extensions). You should also verify that the track is still active in the pressplay 
system by trying to play the download.  
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Try burning again with active pressplay tracks, using the pressplay application. 

B.K.5 The CD Burn process starts normally, but then aborts with the generic message "An error 
has occurred and burning was unable to complete. Please try again. " 

As with other CD burning applications, several factors might interrupt the burn process: 

• The performance of your system  

• The size and number of the files you are recording  

• Older device drivers (8-/16-bit drivers)  

• Other applications running at the same time  

• The quality of the recordable media 

May we suggest the following tips the next time you try to burn tracks to see if you see any 
improvements: 

• Avoid multi-tasking and using other applications while burning  

• Consider a different brand of CD-Rs  

• Disable screen savers and ALL power management  

• Do not record from a compressed drive  

• Log off all network connections 

These are general principals/advice that apply whenever you burn a CD, not just from within 
pressplay. 

B.K.6 General burn failure due to slow connection speed and many tracks. 

When you attempt to burn a CD, the server must first be contacted to obtain the information for the 
tracks. If you have a slower connection speed, or are attempting to burn a lot of tracks (at least 10), 
it is possible that the connection to the pressplay server is timing out before you can receive the 
track information for your burn. 

The default timeout period is 20 seconds, which is optimal for most configurations. If you are 
having issues, we suggest you try increasing this timeout period during your next burn attempt. To 
increase the timeout period: 

 

1. Launch pressplay. 

2. <CLIENT>  Choose File > Options, then go to the Advanced tab. 

<9 SERIES>  Choose OPTIONS/HELP from the HOME tab, then click the Advanced link.  

3. Increment the Timeout for network communications value to 25 or 30 seconds.  
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Note: If you are using a dial-up connection and are burning more than 12-15 tracks, then 
you may want to increase this value to 40 seconds or more. If you do, you should change 
this value back to 20 after you have completed your burn so pressplay will run optimally. 

4. Exit pressplay and then sign back in. 

5. Try your burn again. 

B.K.7 Where can I find help for Fellowes/Neato products?  

For more information on Fellowes/Neato products, go to the following URLs: 

http://www.fellowes.com/  

http://www.neato.com/  

For help with your Fellowes/Neato products, contact their support department at 
feltech@neato.com or call toll free 866.775.7860. 

B.K.8 Where can I get help for my CD Stomper or other Avery Dennison products?  

For more information on the CD Stomper or other Avery Dennison CD labels and products, go to 
the following URL: 

http://www.cdstomper.com/  

For help with your CD Stomper or other Avery Dennison products, contact the Avery Consumer 
Service Center at 888-426-2914 or consumersupport@cdstomper.com. 

B.K.9 <CLIENT>  General failure during PD transfer (actions not corresponding to commands). 

The pressplay PD transfer functionality uses function calls to Windows Media Player 7 or Windows 
Media Player 8 that assume United States English is the language set in your operating system. If 
you are using another language setting besides United States English, you may experience 
unpredictable results. This is not an issue with Windows Media Player 9 Series, which is now 
available as a free upgrade. 

To change your language to United States English: 

 

1. From Windows, select Start > Settings > Control Panel > Options. 

2. Go to the General tab. 

3. Under Your locale (location), select United States (English). 

4. Click OK. 
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B.K.10 How can I contact SONIC | blue customer support directly?  

For issues related to Rio or Nike psa[play products, please contact SONIC | blue support by phone 
at 503.453.1640, by e-mail at customersupport@sonicblue.com or by visiting their customer 
support site: 

www.sonicblue.com/support 

B.K.11 <CLIENT>  What does the options button on the Roxio plug-in do?  What are the different 
recording qualities?  

Sony Net MD devices allow you to select the recording quality of the tracks that are transferred to 
the Net MD. The default speed for pressplay is LP2 Stereo Recording, which allows up to 160 
minutes of music on one MiniDisc. Songs recorded in the LP2 Stereo Recording mode can only be 
played back on devices compatible with the MDLPTM recording modes. 

B.K.12 <CLIENT>  When I copy to a MiniDisc, it seems slow.  

When you copy a pressplay track to a MiniDisc, the track is converted from the Microsoft WMA 
format to the Sony ATRAC3 format. During the conversion process, the file is optimized and an 
additional file is also created in memory. As a result, the copying process requires additional time. 

B.K.13 <CLIENT>  My OpenMG software opens when I am in the process of copying from 
pressplay to Net MD.  

If this occurs, simply close the Open MagicGate software and continue the process of copying with 
pressplay via the Roxio plug-in. 

B.K.14 <CLIENT>  How can I contact Sony Net MD support directly?  

For issues related to Sony Net MD devices, please visit their support Web site at to see if you can 
find the answer to your question: 

http://www.musiclub.sonystyle.com/supportcenter.jsp?categoryId=9 

If you are still having issues with you Sony Net MD player, call Sony Net MD Customer Support at 
866.456.7669. 

B.K.15 <CLIENT>  How can I contact Sharp Net MD support directly?  

For issues related to Sharp Net MD devices, please visit their support Web site at to see if you can 
find the answer to your question: 

http://www.sharpelectronics.com/products/FunctionFaqs/0,1072,17,00.html  

You can also obtain Sharp Net MD e-mail support at:  

http://www.sharpelectronics.com/global/ContactUsProdSupp/1,1878,,00.html 
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If you are still having issues with you Sharp Net MD player, you can call Sharp customer support at 
80O-BE-SHARP. 

13 Community 

13.1 Community FAQs 

T.F.1. What is the pressplay Message Board? 

The pressplay Message Board is a community forum for pressplay members to exchange 
knowledge, tips, music recommendations, or any other information. You can post a question or 
start a discussion topic using the pressplay Message Board, and other pressplay members can 
post responses. See the pressplay User Guide for more information on how the pressplay 
Message Board works. 

T.F.2. I cannot remember the name of an artist or track I am looking for? 

Using the pressplay Message Board, you can ask the general pressplay community for an answer 
using appropriate hints. For example “What was the name of the band that was featured in that 
movie…?” or “who sings that song that goes …?” 

T.F.3. Are the messages posted on the pressplay Message Board monitored or censored? 

As a general rule, pressplay does not censor its Message Board, but from time to time pressplay 
will make sure that the message board content is suitable for a general audience. pressplay 
reserves the right to remove content that is deemed abusive, hateful, threatening, obscene, 
defamatory, or otherwise objectionable. It is prohibited to use the pressplay Message Board to post 
material that is illegal or otherwise harmful in any way, or that violates third party rights. Advertising 
for profit or other commercial reasons, campaigning, or soliciting on the pressplay Message Board 
is also prohibited.  

T.F.4. How do I create or edit my Public Profile? 

To create a public profile to share you tastes and interests with other pressplay members: 

 

1. <CLIENT>  Select Public Profile from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and follow the Public Profile link.   

2. Click the EDIT button. 

3. Edit the fields and then click SAVE. 

The checkbox at the bottom of the Public Profile indicates whether you want your member name 
displayed when other members view Now Streaming or whether you want your collection to be 
available to other members. To share your Public Profile check the box in front of “I'd like to make 
My Collection and Member Name available …”. If you do not want your member name 
displayed, do not check this box. 
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Note: Please allow 24 hours for updates to the Public Profile to take effect. 

T.F.5. How can I see what other members are listening to? 

You can check out what other members are streaming at any given time, by looking under NOW 
STREAMING on the COMMUNITY tab. Select a genre and sub-genre (optional) and then click 
BROWSE to get a list of the most recent songs streamed for that genre. 

T.F.6. What tracks appear under “Now Streaming”? 

All the streams for the selected genre that are currently being played by pressplay members 
appear under NOW STREAMING. If a member has opted to not share the public profile then the 
member name will not appear, but the track will. If you have opted to not view or hear tracks with 
explicit content, then tracks with the parental advisory flag will not appear under NOW 
STREAMING. 

Note: The tracks displayed under NOW STREAMING refresh every ten minutes. The 
most recent 200 streams in the selected genre display. 

T.F.7. How do I make it so my member name does not appear under Now Streaming? 

Only tracks streamed by members who have shared their public profile appear under NOW 
STREAMING. To opt out of this feature so your member name does not display: 

 

1. <CLIENT>  Select Public Profile from the My Account menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and follow the Public Profile link.   

2. Toward the bottom, uncheck the box in front of “I'd like to make My Collection and Member 
Name available …”. 

3. Click SUBMIT to save your changes. 

Note: Please allow 24 hours for updates to the Public Profile to take effect. 

T.F.8. What does “Save Member” do? 

When you save a member, it flags the member so when you go to the BROWSE MEMBERS’ 
COLLECTIONS sub-tab, the members name will conveniently appear under Saved Members. 

T.F.9. Is the information in the public profiles censored? 

As a general rule, pressplay does not censor the public profiles, but from time to time pressplay will 
make sure that the public profile content is suitable for a general audience. pressplay reserves the 
right to remove content that is deemed abusive, hateful, threatening, obscene, defamatory, or 
otherwise objectionable. It is prohibited to use the public profiles to post material that is illegal or 
otherwise harmful in any way, or that violates third party rights. Advertising for profit or other 
commercial reasons, campaigning, or soliciting with the public profiles is also prohibited. 
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T.F.10. How can I view other members’ collections? 

The BROWSE MEMBERS’ COLLECTION sub-tab (under the COMMUNITY tab) lets you browse 
or search for other pressplay members’ collections to find other members with similar musical 
tastes, and to discover new music. A member’s collection includes tracks that member has 
downloaded or made portable. 

To browse member’s collections: 

 

1. Go to the COMMUNITY tab. 

2. Go to the BROWSE MEMBERS’ COLLECTION sub-tab. 

3. Pick a genre from the drop-down menu. 

4. Click the BROWSE button. 

You can also search for a specific pressplay member’s collection from the SEARCH FOR 
MEMBER sub-tab. 

Also note that when you choose a track and select Find in Member’s Collection from the right-
click menu, all the members who have downloaded that particular track will display. 

 

13.2 Community K-base Only 

T.K.1. <9 SERIES> The Enter key does not work when I try to post or reply to a message on the 
message board. 

We apologize for the inconvenience, this is a known issue that we are working to resolve. This is 
only an issue with pressplay for Windows Media Player 9 Series; if you have the standalone 
pressplay application, the Enter key is fully functional. You can also use the spacebar to create 
extra space if necessary. 

14 Administrative Functions  

14.1 Administrative FAQs 

A.F.1. How do I update my member information?  

To access and update your member information,  

<CLIENT>  Select Member Information from the My Account drop-down menu.  

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and click on the Member Information 
link. 



pressplay K-base  Administrative Functions 

# CC-001  v4.1 — March 27, 2003 

  PROPRIETARY & CONFIDENTIAL Page 96 
 

To update the information, click EDIT. Update the information and then UPDATE MEMBER INFO. 

See the pressplay User Guide for more details. 

A.F.2. How do I change my pressplay genre preference? 

The Member Information page under My Account contains information about genre preference that 
you entered when you registered for pressplay service. To update this information: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and click on the Member 
Information link. 

2. Click the EDIT button. 

3. Use the drop-down menus to change the favorite genre and/or second favorite music 
genre. 

4. After you have made changes, click UPDATE MEMBER INFO to post the changes.  

For more information, see the pressplay User Guide. 

A.F.3. What are all my help options for pressplay? 

pressplay has a few help resources available: 

• Intro to pressplay—a brief overview of pressplay and its capabilities 

• pressplay FAQ—an online database of common questions about pressplay. The FAQs are 
provided in a familiar help format with an index and search functionality. 

• pressplay User Guide—an online procedural manual for using pressplay. The User Guide is 
provided in a familiar help format with an index, glossary, and search functionality. 

• Customer Care—a link to pressplay Customer Care, where you can fill out the help or 
feedback forms to get quick and reliable service from a pressplay Customer Care 
representative  

To access help options: 

<CLIENT> Press the F1 key on your keyboard or select the Help drop-down menu. Note that help 
is available when you are in LISTEN OFFLINE mode as long as you have an active Internet 
connection.  

<9 Series>  Go to the HOME page and click OPTIONS/HELP, and then click the Help link.  

A.F.4. What does Refresh Track Options do? 
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Choosing Refresh Track Options will manually update the stream, download, burn, and transfer 
options for tracks under MY COLLECTION or BOOKMARKED TRACKS to match what is 
currently available in the pressplay system. These options (with the exception of stream options) 
are automatically refreshed monthly, but this is a way to manually trigger the refresh. To refresh 
stream options, you can do this manually using the Refresh Track Options feature. 

To refresh your track options: 

<CLIENT> Select Refresh Track Options from the My Account drop-down menu. 

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and click on the Refresh Track 
Options link. 

A.F.5. How do I change my notification messages options? 

When you perform certain actions in pressplay such as bookmark tracks, pressplay may give you 
an visual notification that this action has been completed. To configure these options: 

<CLIENT>  Select Options from the File drop-down menu, and then click the Messages tab. 
There are various options that can be changed by selecting or de-selecting the corresponding 
checkbox: 

• Notify at startup if Windows large font setting is detected—if you want to continue to use 
large fonts and do not want to be notified every time you sign in, then de-select this box 

• Notify after sign in if any tracks need repair—if a defective track has been updated since 
you downloaded it, you will automatically be prompted to repair this track as long as you have 
this box selected. If you choose not to be notified, then you may have issues with some 
downloads then cannot be repaired until you select this option. 

• Tracks have been added to My Collection—if you want to be notified every time you add 
tracks to the My Collection tab, then select this box 

• Tracks have been added to a playlist—if you want to be notified every time you add tracks 
to a playlist, then select this box 

• A playlist has been added to My Collection—if you do not want to be notified every time 
you add a playlist to your collection, then de-select this box 

• Music is playing when I exit pressplay–if you want to be notified if you try to close pressplay 
when tracks are still playing, then select this box  

• A custom radio station is created—if you want to be notified every time you create a new 
custom radio station, then select this box 

<9 SERIES>  Click OPTIONS/HELP from the HOME page, and click on the Messages link. There 
are various options that can be changed by selecting or de-selecting the corresponding checkbox: 

• Notify after sign in if any tracks need repair—if a defective track has been updated since 
you downloaded it, you will automatically be prompted to repair this track as long as you have 
this box selected. If you choose not to be notified, then you may have issues with some 
downloads then cannot be repaired until you select this option. 
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• Tracks have been added to Bookmarked Tracks—if you want to be notified every time you 
bookmark a track, then select this box 

• Tracks have been selected for downloading—if you want to be notified every time you 
select a track to download, then select this box 

• Windows large font setting is detected—if you want to continue to use large fonts and do 
not want to be notified every time you sign in, then de-select this box  

• A custom radio station is created—if you want to be notified every time you create a new 
custom radio station, then select this box 

14.2 Administrative K-base Only 

A.K.1. How can I exclude myself from promotional e-mails? 

On occasion, pressplay or its partners may send you special promotional e-mails. You will only be 
sent e-mails if you checked this option during registration. If you do not wish to receive e-mails: 

 

1. <CLIENT>  Select Member Information from the My Account drop-down menu. 

<9 SERIES>  Go to OPTIONS/HELP from the HOME tab and click the Member Information 
link. 

2. Click the EDIT button.  

3. Deselect either of the two selection boxes at the bottom of the page to discontinue e-mails sent 
to you from pressplay or its partners. 

4. After you have made changes, click UPDATE MEMBER INFO to post the changes. 

Note that these selections do not pertain to important membership and major service revision e-
mails that are automatically sent to all members. Also note that when a member cancels, we may 
send several notifications. 
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BROWSE MEMBERS’ COLLECTION, 94 
BROWSE NEW ADDITIONS, 48 
Browser, 17 
buffer, 52 
buffering, 9 
burn, 6 

cancel, 76 
defective, 87 
slow connection speed, 89 

burn album, 75 
Burn and Transfer KB Only, 77, 87 
burn credits, 75 
burn failure, 89 
burn format, 81 
burn option, 77, 80 
burn or transfer-only tracks, 77 
burn patience, 81 
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burn session, 82 
BURN TO CD, 79 
burner not detected, 87 
burning 

general tips, 89 
burning directly, 81 
Burning FAQs, 78 
burning in trial, 77 
burning Portable Downloads 

9 Series, 79 
client, 78 

burning software, 80 
burning was unable to complete, 89 
burning with other applications, 81 
Business Development inquiries, 14 
buy a CD, 11 
buy more Portable Downloads, 38 
cable, 52 
cancel 

billing, 39 
cancel burn, 76 
cancel membership, 33 
canceling a burn, 81 
cancellation, 42 

within 3 days of DPT, 42 
within trial, 41 

Cannot Copy status, 82 
cannot launch WMP, 84 
cannot stream or download, 54 
Caps Lock, 32, 49 
carry over, 75 
case-sensitive, 32, 49 
catalog, 46 
categories, 3 
CD audio format, 81 
CD burner, 80 
CD burner engine, 80 
CD Burners, 80 
CD burning 

9 Series, 79 
client, 78 

CD Burns, 78 
CD format compatibility, 81 
CD Label Creator, 82 
CD Label Creator help, 82 
CD labels, 90 
CD purchase, 11 
CD Stomper, 90 
CDA, 81 
CD-RW, 81 
censorship policy 

message boards, 92 
certificate has expired, 22 
change .NET Passport auto sign-in, 44 
change membership plan, 35 
changing order on Net MD, 87 
changing parental control password, 49 

check cards, 18 
clear completed, 67 
clearing DOWNLOAD STATUS, 67 
client installation issues, 31 
Closing to Customer Care e-mails, 17 
Closure, 16 
code, 3 
community forum, 92 
Compaq iPAQ 

support, 85 
Compaq iPAQ drivers, 85 
compatible portable devices, 82 
compensation to label, 40 
computer crash 

sync/restore, 72 
concurrent user, 37 
connection speed, 12, 52 
contact Customer Care, 9 
content availability, 50 
cookies, 8 
copy 

defective, 87 
copy Portable Downloads, 75 
Copy to CD or Device, 79, 83 
copy to Net MD 

slow, 91 
COPY TO NET MD, 86 
copying 

CDs, 87 
copying downloads, 69 
copying tracks to other computers, 66 
copyright infringement, 8 
corrupted license, 54 
create label, 82 
creating playlists 

9 Series player, 58 
client, 57 

Creative NOMAD, 85 
credit card, 23 

switching, 36 
credit card information, 4, 18, 36 
credit cards, 18 
Credit Floor, 43 
Customer Care, 9, 95 
Customer Care logging, 55 
Customer Support 

Windows Media, 10 
cycles back to ready, 56 
data structure and flow, 2 
Db.bin corruption, 71 
Dcom98.exe, 29 
Debit cards, 18 
default player, 57 
defective burn or transfer, 87 
defective download, 69 
Defective Stream, 55 
deleting 
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downloads, 67 
delivery 

stream and download, 53 
detect CD burners, 87 
device not recognized, 84 
Device Status, 88 
dial-up, 52 
Digital Rights Management, 10 
direct billing, 23 
discussion topic, 92 
Display preferences, 13 
distribute CDs, 87 
downgrade membership plan, 35 
download, 6 

bitrate, 68 
copying, 66 
deletion, 67 
expiration, 65 
option, 64 
permanence, 65 
progress, 67 
same song, 67 
storage, 69 

download delivery, 53 
Download Directory, 69 
download failure, 70 
Download FAQs, 64 
Download K-base Only, 68 
download location, 65 
download pressplay, 19 
download restore, 66 
DOWNLOAD STATUS tab, 67 
download storage 

9 Series, 69 
client, 69 

download time 
pressplay application, 21 

download track 
quality, 65 

downloading, 64 
downloading albums, 67 
downloading issues, 54 
downloads 

listening offline, 67 
downloads in playlists, 61 
DRM, 10 
DRM cannot be Individualized, 28 
DSL, 52 
Easy CD Creator, 81 
editing playlists 

9 Series player, 58 
client, 57, 58 

e-mail from pressplay, 46 
e-mail list, 97 
e-mail with attachments, 15 
e-mailing downloads, 68 
emerging artist, 50 

enable Active X, 25 
enable Customer Care logging, 55 
endless installation circle, 25 
enqueue, 9 
Enter key, 94 
ERROR LOADING TYPE LIBRARY/DLL, 29 
Escalation information, 15 
exclude explicit content, 48, 49 
explicit content 

allowing tracks with, 49 
blocking tracks with, 48 

explicit content block, 49 
F1, 9, 95 
failure 

burn or transfer, 87 
FAQ, 2, 95 
favorite genre, 95 
featured tracks, 54 
Feedback, 15 
Fellowes/Neato, 90 
file extension, 57 
file format 

download, 65 
streaming, 4, 52 

file format not supported, 88 
file types, 57 
finalizing session, 82 
Find in Member’s Collection, 94 
Finding Music K-base Only, 50 
firewall, 18 
flash, 83 
flash tour, 5 
font preference, 13 
font size, 13 
ForceRenew.exe, 72 
forgot password, 39 
format not supported, 88 
format of burns, 81 
forum, 92 
fraud, 37 
free, 10 
free trial, 18, 23, 31, 32, 35 
General FAQs, 4 
General K-base Only, 10 
genre preference, 95 
get more Portable Downloads, 4, 38 
get recommendations, 47 
getting info 

download, 70 
hack, 12 
hangs 

installation, 25 
Hard Drive, 17 
hard drive failure, 66 
Hear This! e-mails, 97 
Help, 9, 95 
help for CD label, 82 
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help options, 95 
help request, 9 
hidden file extension, 57 
home, 19 
how many burns, 75 
How many subscribers, 15 
How to burn 

9 Series, 79 
client, 78 

How to copy to Net MD, 86 
how to transfer 

9 Series, 83 
client, 83 

IE security settings, 25 
iKernel.exe, 29 
independent record label, 11 
individualization failed, 54 
individualization problems, 26 
information 

artist/album, 48 
information gathering template, 15 
install, 21 
installation failure, 21 
installation FAQs, 17 
installation issues, 31 
installation locks up, 25 
installation problems, 25 
installation URL, 31 
InstallShield, 25, 29 
InstallShield knowledge-base, 29 
Insufficient Funds, 43 
international availability, 5 
internet connection, 40 
Internet Explorer version, 24 
Internet settings, 40 
Intro to pressplay, 95 
introduction, 2 
invalid password 

parental control, 49 
iPAQ drivers, 85 
ISDN, 52 
ISP software, 56 
just added, 48 
KB only, 3 
Kbps, 52 
keeping downloads, 34 
label compensation, 40 
label for CD, 82 
labels, 47 
LAN Settings, 40 
language, 90 
languages 

music in other, 50 
large fonts, 13 
launch, 5 
license renewal, 67 
limit 

playlists, 58, 59 
limit of Portable Downloads, 75 
listening to playlists 

9 Series player, 59 
client, 59 

loading, 56 
loading a playlist, 59 
log 

Customer Care, 55 
log-in, 10 
lost pressplay, 19 
LP2 Stereo Recording, 91 
Macintosh, 23 
Make Portable, 74 

twice, 76 
making a track portable, 74 
Mastercard, 18 
Media Library, 65, 66, 68 
media-related questions, 9 
member information, 94 
member name 

changing, 37 
hide, 4, 93 
recovery, 43 

Member Name 
shared, 92 

membership 
lapse, 39 

Membership FAQs, 32 
membership must be updated, 28 
membership plan 

upgrade, 35 
membership plans, 32 
Memory, 17 
Message Board, 92 

censorship, 92 
Message Board FAQs, 92 
Message Board K-base Only, 94 
messages options, 96 
Microsoft technical support, 28 
Microsoft Web site, 18 
MiniDisc, 85, 86, 91 
minimum system requirements, 4, 17 
minimum time commitment, 18 
missing artist, 46 
missing download, 67 
Missing Registry Key Error, 22 
monitoring download usage, 68 
moving downloads 

9 Series, 69 
client, 69 

MP3.com, 40 
MP3s, 7 
MSN .NET Passport, 39 
multiple .NET Passports, 43 
multiple charges, 41 
multiple sessions, 7 
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multi-tasking, 65 
music player, 52 
Music Player, 17 
Music Programming, 11 
mute, 7 
muted, 7 
My Collection 

shared, 92 
MY COLLECTION, 47 
My Music directory, 65 
Neato, 90 
Net MD copy, 86 
Net MD device, 85 
Net MD not recognized, 86 
Net MD options, 85 
Net MD support, 87, 91 
NET Passports 

multiple, 43 
Netscape, 21 
new additions, 48 
new computer, 66 
New k-base articles, 2 
new pressplay releases, 46 
Nike customer support, 91 
Nike psa[play, 85 
No CD burning devices detected, 87 
no device listed, 84 
no more uses 

unlimited downloads, 72 
no stream or download options, 77 
no volume, 7 
non-pressplay content 

playlists, 63 
non-pressplay tracks, 7 
Norton AntiVirus, 27 
not able to sign in, 32 
not recognized, 86 
nothing happens when burning, 81 
notification messages options, 96 
Now Playing 

Radio pressplay, 63 
Now Streaming, 93 
NOW STREAMING, 93 
NT, 17 
number of transfers allowed, 76 
numbering convention, 2 
online, 53, 67 

burning, 76 
online help, 95 
open Windows Media Player, 84 
OpenMG  Jukebox, 86 
OpenMG Jukebox 2.2, 85 
OpenMG software, 91 
Operating System, 17 
operating system version, 23 
opt-in, 46 
option to burn or transfer, 77 

options 
Roxio plug-in, 91 

OS upgrade, 12 
other customer's information, 15 
other players, 68 
other sources, 63 
Out of Scope Reply, 15 
overview, 5 
pack, 74 
parental control password, 49 

recovery, 50 
setting, 49 
turning off, 51 

partial string search, 46 
password 

parental control, 49 
Password Recovery, 43 
password recovery process, 39 
Payment Decline Notice, 36 
Payment rejected, 43 
PD transfer 

9 Series, 83 
client, 83 
general failure, 90 

PD Transfers, 78 
performance 

burning, 89 
performing other actions while burning, 81 
performing other tasks while downloading, 65 
permanent download, 65 
permissions settings, 13 
personal use, 87 
ping, 12 
playback quality, 52 
Playback skips, 12 
players 

other, 68 
playing albums, 53 
playing CDs, 81 
playing downloads, 66 
playing tracks, 51 
playlist 

limit, 58 
sharing, 63 

playlist actions offline, 61 
Playlist and Radio FAQs, 57 
Playlist K-base Only, 63 
playlist listening 

9 Series player, 59 
client, 59 

playlists 
limit, 59 
listening on other computers, 63 
with downloads, 61 
with streams, 61 

popularity, 46 
popularity rating determination, 46 
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PopUp Killer, 13 
port scan, 12 
portable device, 82 
portable device not recognized, 84 
portable device support, 4, 85 
portable device transfer, 6 
portable devices, 82 
Portable Download, 4, 6 

expiration, 76 
limit, 75 
transfer, 75 

Portable Download credits, 38, 75 
Portable Download pack, 74 

purchase, 38 
Portable Download packs, 38 
Portable Download Packs, 32 
Portable Downloads, 74 
Portable Downloads in trial, 77 
Portable Downloads keeping, 34 
portable music players, 82 
post-installation issues, 22 
press inquiries, 12 
pressplay, 4, 19 
pressplay application, 20 
pressplay charts, 46 
pressplay for Windows Media Player 9 Series, 4, 

5 
pressplay installation URL, 31 
pressplay memberships, 32 
pressplay radio, 62 
pressplay version, 31 
pressplay_installer.exe, 31 
privacy, 8 
Privacy Policy, 5 
Processor, 17 
promotional e-mails, 97 
proxy server, 40 
proxy server settings, 56 
proxy settings, 70 
Public Profile, 92 
public profile censorship, 93 
purchase a Portable Download pack, 38 
purchasing downloads, 74 
queue up tracks, 9 
Radio pressplay, 4, 62 

9 Series player, 63 
actions, 62 
delivery, 62 
duration, 62 
listening, 62 

Radio pressplay updates, 62 
random, 61 
reactivate, 33, 39, 66 
ready, 56 
re-buffer, 52 
recently added tracks, 48 
recommendations, 47 

Recommended Artists, 47 
recovery 

parental control password, 50 
Refresh Track Options, 77, 95 
Refund Denial Response, 42 
refund policy, 11 
refund timing, 42 
regain access, 66 
Registration and Installation FAQs, 17 
Registration and Installation K-base Only, 21, 23, 

32 
registration not successful, 29 
reinstall, 22 
re-install plug-in for 9 Series, 21 
releases, 46 
remove pressplay, 30 
removed 

tracks, 53 
renaming downloads, 65 
request account information, 43 
requesting tracks, 54 
reset DRM, 28 
resizing, 7 
Resolved Issue, 16 
restart download, 70 
restoring downloads, 66 
returning customer, 66 
Rio, 85 
Rio customer support, 91 
Roxio Basic CD Label Creator, 82 
Roxio Basic CD Label Creator help, 82 
Roxio burn software, 80 
Roxio CD burning software help, 81 
Roxio Easy CD Creator, 80 
Roxio plug-in, 91 
Roxio supported CD RWs, 80 
royalties, 40 
royalty tracking, 68 
Save Member, 93 
scrambled track, 69 
SD, 83 
search for content, 45 
SEARCH FOR MEMBER, 94 
search tips, 46 
Secure Digital, 83 
security, 18 
security settings, 18 
sending downloads, 68 
Service Pack, 23 
Services, 21 
session finalizing, 82 
sessions, 7, 8 
sharing 

membership, 37 
sharing playlists, 63 
Sharp Net MD support, 87, 91 
shuffle, 61 
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sign in issues, 32 
sign up 

via Customer Care, 23 
sign-in, 10 
sign-in error, 40 
skips, 69 
slow, 12 
slow Net MD copy, 91 
small fonts, 13 
SONIC | blue, 85 
SONIC | blue customer support, 91 
SonicStage on Vaio, 85 
Sony Net MD, 6 
Sony Net MD support, 87, 91 
sound card, 7 
Sound Card, 17 
speakers, 7 
special characters, 46 
SSL, 18 
SSL 2.0, 40 
start, 5 
status of download, 67 
storing downloads, 65, 69 
stream, 6 
Stream Fix.reg, 57 
stream management, 53 
streamdb.bin, 55 
streaming, 53 
Streaming FAQs, 51 
streaming issues, 54 
Streaming K-base Only, 54 
streaming tracks, 51 
streams in playlists, 61 
stuck on getting info, 70 
stuck on loading, 56 
submissions, 11 
subscribers, 15 
subscription management, 40 
support for PD, 4, 85 
support for Roxio, 81 
supported portable devices, 82 
switch credit card, 36 
switch member name, 37, 38 
sync/restore 

Portable Downloads, 75 
Sync/Restore, 39, 66, 72 

additional, 72 
timing out, 72 

system date, 40 
system failure, 66 
system requirements, 4, 17 
system resources, 12 
tablog.txt, 55 
technical difficulties, 12 
temporary difficulties, 12 
terminated session, 8 
time commitment, 18 

time limit to use Portable Download, 76 
timeout period, 72 

burning, 89 
today just added, 48 
top ten FAQs, 4 
Total Recorder, 12 
tour, 5 
track 

download, 64 
track availability, 64 
track is no longer available, 71 
track is not available, 56 
Track Options, 95 
track renewal, 67 
transfer, 6 

cancel, 76 
defective, 87 

transfer album, 75 
transfer option, 77 
transfer Portable Downloads, 75 
transfer requirements, 82 
transfer to PD 

9 Series, 83 
client, 83 

transfers per Portable Download, 76 
Unable to access this media, 56 
unable to update membership, 40 
unauthorized user, 37 
uninstall and reinstall pressplay, 22 
uninstall pressplay, 30 
Unlimited, 32 
unlimited downloads 

no more uses, 72 
Unlimited Plus, 32 
update billing information, 41 
update burn options, 95 
update member info, 94 
update membership, 40 
Update pressplay, 19 
updating selections, 64 
upgrade, 35 

Roxio software, 80 
upgrade individualization, 54 
upgrade OS, 12 
upgrade WMP individualization, 26 
upgrades 

pressplay, 19 
Use a proxy server, 56 
User Guide, 95 
VeriSign, 28 
version, 19 

9 Series player, 13 
version of pressplay, 31 
version of WMP, 24 
versions of pressplay, 20 
view other members’ collections, 94 
virus warning during installation, 27 
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viruses, 27 
Visa, 18 
volume, 7 
volume adjustment, 53 
VUNet USA Technologies, 40, 53 
Welcome Back to pressplay, 33 
why, 10 
Why download, 64 
Windows 2000, 13 
Windows Media Player, 11, 18, 24, 52 

installation, 26 
Windows Media Player 9 Series, 4, 5, 33, 68 

version, 13 

Windows Media Player 9 Series Customer 
Support, 10 

Windows Media Player upgrade failure, 54 
WMP, 18 
WMP Stream Fix.reg, 56 
WMP version, 24 
wmp.ocx, 26 
WMP_Upgrade.wma, 40, 54 
work, 19 
XP, 13 
Your membership must be updated, 71 
zero subscriptions, 29 
Zip disk, 69 
Zip drive, 69 
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